Oracle Talent Management Cloud
Using Learning
Release 13 (update 18B)
Part Number E94268-02
Copyright © 2011-2018, Oracle and/or its affiliates. All rights reserved.

Authors: Gayathri Akkipeddi, Juliette Fleming, Hema Hardikar, Lakshmi VR, Allison Nicholson

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services unless otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as set forth in an applicable agreement between you and Oracle.

The business names used in this documentation are fictitious, and are not intended to identify any real companies currently or previously in existence.
# Contents

**Preface**

1 **Overview**

   Oracle Learning Cloud: Overview

2 **Social Learning**

   Social Learning: Examples
   Fostering a Collaborative Learning Approach: Critical Choices
   Publishing a Video: Procedure
   Authoring a Tutorial: Worked Example
   Social Networking with Learning: Explained
   FAQs for Social Learning

3 **Employee Self-Service**

   What to Learn Page: Explained
   My Learning Page: Explained
   Searching for Learning Items: Explained
   Request Learning Item: Procedure
   Request Learning Item: Procedure
   Request Noncatalog Learning Item: Procedure
   Enrolling Yourself in Learning Items: Procedure
   Completing an Evaluation: Procedure
   Courses and Specializations for Learning Outcomes: Worked Example
   FAQs for Employee Self-Service

4 **Manager Self-Service**

   Promoting Learning to Your Team: Points to Consider
   Recommending a Learning Item: Procedure
   FAQs for Manager Self-Service
5 Learning Communities

Learning Communities: Overview
My Learning Communities: Explained
Manage Learning Communities in Learning Administrator Work Area: Explained
Create and Manage Communities
FAQs for Learning Communities

6 Courses

Learning Components: How They Work Together
Courses: Explained
Creating a Course: Worked Example
Learning Outcomes: Explained
Content Types for Learning Outcomes: Examples

7 Specializations

Specializations: Explained
Creating a Specialization: Worked Example

8 Learning Content

Learning Content: Explained
Importing and Uploading Learning Content: Procedure

9 Offerings

Offerings: Explained
Defining an Offering and Its Activities: Explained
Creating an Offering and Activity: Worked Example
Learning Evaluation: Explained

10 Learning Assignments and Learning Initiatives

Learning Assignments: Explained
Learning Initiatives: Explained
Rules for Learning Assignments and Learning Initiatives: Explained
Assignment Statuses: Explained
Creating a Learning Assignment: Procedure
Managing Learners: Procedures
Manage Learning Assignments and Learning Initiatives: Explained
FAQs for Learning Assignments
## 11 Contextual Learning

- Contextual Learning in Application Pages: Explained
- Configuring Learning Showcase Component: Points to Consider
- Configuring Learning Assignment Component Options: Points to Consider
- Adding and Configuring Learning Components to Job Roles: Worked Example
- FAQs for Contextual Learning

## 12 Learning Setup

- Evaluations
- Social Network Conversations
- External Providers
- Profile Options for Learning Features: Explained
- Scheduled Processes in Oracle Learning Cloud: Overview
- Creating Deep Links in Learning: Procedure

## 13 Security

- Standard Application Users for Oracle Learning Cloud: Overview
- Standard Learning Administrators: Explained
- Standard Learners: Explained
- Standard Learner Managers: Explained
- Custom Learners: Explained
- Custom Learner Managers: Explained
- Custom Learning Administrators: Explained
- Custom Learning Moderators: Explained
Preface
This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help
Use help icons 🎨 to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle Applications Help.

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community:** Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.
- **Guides and Videos:** Go to the Oracle Help Center to find guides and videos.
- **Training:** Take courses on Oracle Cloud from Oracle University.

Conventions
The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility
For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Overview

Oracle Learning Cloud: Overview

Learning is available for everyone, anytime, anywhere. Learners can discover, consume, publish, and collaborate using the social features of liking, recommending, or contributing to the conversation. They can also download content to mobile devices to consume learning offline.

Oracle Learning Cloud is an Enterprise Learning Management System. We have re-imagined learning for how learners want to learn, how managers want to manage their team’s learning, and how administrators want to deploy and track compliance and development-based learning.

Learners can discover and consume learning that is relevant to their job roles. Subject matter experts can easily share their knowledge with the rest of the organization and gain recognition for their contributions. Managers can push learning to their teams and track the teams progress.

HR specialists can manage the learning catalog and drive compliance needs by administering required learning across the entire organization. Learning specialists can assemble online offerings, courses, and specializations using videos and SCORM-compliant content.

Manage Learning Catalog

The learning administrator builds the learning catalog by adding learning items. A learning item can be a course teaching a topic. A course can be offered in different flavors, in different places, and on different dates and times. An offering for a course, for example, an e-learning offering can be consumed when and where it is convenient for the learner or an instructor-led offering taking place on 1 June at Head Quarters. A learning item can also be a specialization which is a collection of courses that belong together.

Self-Paced Learning

A self-paced offering is created by the learning administrator and consumed directly by the learner. The self-paced learning is normally e-learning. Many different types of e-learning can be used in Oracle Learning Cloud such as SCORM content, AICC content, PDF documents, videos, or a web page. Self-paced learning doesn’t take place at a specific time, it takes place when it is convenient for the learner.

Instructor-Led Learning

The instructor-led learning is learning where an instructor is present. The instructor-led learning can be online and is then referred to as virtual instructor-led training or web cast. The instructor-led learning can be offline, which is traditional classroom training with an instructor. Schedule offerings with instructor-led activities can have trainers, venues, and other resources attached. The instructor-led learning always takes place at a specific time and if offline, a specific place.
Blended Learning, Specializations, and Communities

An offering can consist of both self-paced and instructor-led activities and is then called a blended learning offering. Another way for the learning administrator to offer blended learning is to create a specialization. A specialization is a collection of courses. Each course can have both instructor-led and self-paced offerings, it is then up to the learner to decide what is most convenient. The learning administrator groups courses together in a specialization to show the learner that the courses belong together.

A community is another way for the learning administrator to provide learning for the learners. In a community learners can view the community content and participate in discussions.

Learning Assignments and Initiatives

The learning administrator signs up learners for courses, offerings, and specializations. It is done using either an assignment or an initiative. An assignment signs up a specific group of learners to a specific course, offering, or specialization. When the learner is signed up for a learning item, the learner can view information regarding the learning item and take the training, if it contains e-learning.

An initiative is an ongoing activity automatically ensuring a group of learners are signed up for a specific learning item. For example, an initiative can secure that everybody in the HR organization are automatically signed up for the offering, HR Procedures in ABC Corp. So, when a new employee is joining the HR organization, they will be automatically be signed up for the HR Procedures in ABC Corp.

Social Learning

Social learning is created and managed by the learners themselves. Oracle Learning Cloud encourages collaborative learning and makes it easy for all employees to share their knowledge by uploading videos and creating tutorials. It is also possible for all users to like, recommend, and comment on other learner’s contributions.

Social learning is an integrated part of Oracle Learning Cloud and is made available to users based on the organization’s procedures and policies.

Getting Started

To get started, review the information about provisioning and configuration in the Oracle Learning Cloud master article (2158160.1) on My Oracle Support at https://support.oracle.com

Related Topics

- Fostering a Collaborative Learning Approach: Critical Choices
- Learning Components: How They Work Together
- Oracle Learning Cloud - Master Article on My Oracle Support
2 Social Learning

Social Learning: Examples

Employees can capture, share, and collaborate around best practices using rich media. This topic suggests some scenarios where businesses can benefit from this social learning.

Sharing Solutions

Services engineers are in the field, solving customer problems. To rapidly share knowledge of solutions, an engineer can publish a video demonstrating a fix to a common customer issue. Through recommendations and sharing on Oracle Social Network, the knowledge can immediately be spread throughout the team.

Best Pitch Video Competition

The stars on your sales team can publish recordings of their sales pitches for new products and services. Or why not harness the competitive spirit and encourage the whole sales team to record their pitches for judging by their peers? The video with the most Likes is the winner.

Best Practices

Subject matter experts find the most effective approaches through their experience. You maximize the return on that experience if these experts share their knowledge in an engaging video or tutorial. For example, a field technician might publish a tutorial on installation best practices for a new offering.

Fostering a Collaborative Learning Approach: Critical Choices

Many skills evolve too quickly for formal learning plans to keep pace. To remain competitive, encourage grassroots social learning, to complement your formal learning offerings. Social learning helps you maximize performance by equipping your employees with best practices, newest methods, and latest technologies for their work.

To create a positive environment for employee-to-employee learning, you may need to adjust your organization’s culture. Managers throughout the enterprise can use their leadership to empower and encourage collaboration and knowledge-sharing.
The following figure depicts the virtuous circle where social recognition and management encouragement inspire growing involvement in social learning.

Remove Barriers to Publication

The first step is to enable practitioners to publish their knowledge with minimal interference. Long approval chains and demanding standards are likely to dampen enthusiasm and prevent timely publication. With a more hands-off approach, you expose varied points of view on topics and help your enterprise community to self-curate. You can also actively engage subject matter experts to publish their content, ensuring that their expertise is shared first.

Note: Depending on your organization requirements, to publish your videos and tutorials may require an approval. For example, if your organization implements an approval for publishing a video, when you upload your video, the application sends an approval request to your concerned approval authority.

Encourage Collaboration

Executives can set an example by actively publishing and sharing insights with your community. Managers contribute by:

- Requiring completion of certain learning items by their teams
- Encouraging peer-to-peer recommended learning
- Assisting workers to find better ways of doing their work using employee-sourced knowledge

By their own example and the expectations they set, managers can foster a sense of communal shared liability for intellectual property.
Recognize and Reward Contributors

Enhanced reputation through Likes and Recommendations of their content will motivate many contributors. But you can assist by recognizing and rewarding your key contributors in other ways, for example at team meetings or events. By surfacing the social credibility of your subject matter experts, you can ensure that the best knowledge rises to the top.

Train on Content Creation

Not everyone has the skills to share their knowledge effectively. If you have experts who are slow to get involved, you can provide training on content creation. As you help employees convey their knowledge in concise and engaging stories, the quality of your learning resources will improve.

Related Topics

- Promoting Learning to Your Team: Points to Consider
- Learning Communities: Overview

Publishing a Video: Procedure

Share your knowledge by publishing learning items. You can upload and publish videos or author tutorials in the What to Learn, My Learning, and My Team pages.

You can publish videos as follows:

1. From the What to Learn page, click the Publish Video link.
   You can publish a video from the Actions menu in the My Learning and My Team pages.
2. In the Publish Video window, browse and select the video file. You can also drag and drop the video file.
3. As the video upload process goes on, you can set the options for the video. Enter a Title and Description of the video.
   The description you enter is displayed in the About field on the video card.
4. Specify one of the video Visibility options:
   - Select Open so that anyone can search and view the video.
   - Select Secret so that only select people can view the video.
5. If the video is set to Secret, select and specify the people who can access the video.
6. Verify the details and click Publish.

A message appears that the video is under processing and a notification will be sent to you. You can find the video listed in the Contributions content area of My Learning page. You can modify the settings of the video later too.

Authoring a Tutorial: Worked Example

This example demonstrates how to create a tutorial, New Employee Handbook, and recommend the tutorial to various members in the organization. You can assemble multiple pieces of mixed-media content in a tutorial. The sections are
specific to the tutorial. You can’t reuse them in other tutorials. The content can be self-authored or authored by others, on a specific topic from various sources:

- Content in Oracle Learning Cloud
- Content on your system
- References to content from external sites
- Videos from YouTube

This example comprises the following four tasks in authoring a tutorial:

- Creating a tutorial
- Creating a section with an external video, such as YouTube
- Creating a section with a Web link
- Creating a section with an internal video

Any employee can author a tutorial. You can recommend it to anyone in your enterprise.

Creating a Tutorial

1. On the home page, click **About Me** and then **Learning** to open the **What to Learn** page.
2. Click **Author Tutorial**.
   You can create a tutorial from the Actions menu in the My Learning and My Team pages.
3. In the **Author Tutorial** page, specify the following attributes:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>New Employee Handbook</td>
</tr>
<tr>
<td>Description</td>
<td>This is the place to get basic facts about the company, and to learn about how Vision Corporation is dedicated to innovation by simplifying IT.</td>
</tr>
</tbody>
</table>

4. Click **Set the Visibility**.
5. In the **Tutorial Visibility** window select **Open** for anyone to find and view the tutorial.

   The **Create Section** tile is in the tutorial table of contents.

Creating a Section with an External Video

1. On the Author Tutorial page, click **Add New Section** and complete the fields on the **Author Section** page:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Welcome to Vision Corporation</td>
</tr>
</tbody>
</table>
Field | Value
---|---
Description | Vision Corporation thrives because of the exceptional talent we have attracted to our team. Our employees are creating the technologies of tomorrow. Executive Chairman and Chief Technology Officer

2. Click **Add Video**.
3. Click **Search YouTube**.
4. Search by keywords or title, the New Employee Welcome video and click **Select**.
5. Verify the details in the section and click **Done**.
6. Click **Save**.

You can save a tutorial only after you provide the title, description, visibility option, and at least one section. After you save the tutorial, you can come back to the tutorials and build more sections. You can update a tutorial at any time but can't version it.

Creating a Section with a Web Link

1. On the **Author Tutorial** page, click **Add New Section** and complete the fields on the **Author Section** page:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Your Vision Corporation Career Comes with Unmatched Benefits</td>
</tr>
<tr>
<td>Description</td>
<td>Vision Corporation not only provides you with the rewarding career development you're seeking, but also with unmatched benefits that help you get the most out of your career and your life.</td>
</tr>
</tbody>
</table>

2. Click **Add a Web Link**.
3. In the **Web Link Selection** window enter or copy the Web link.
4. Select a cover art image and upload it from your desktop.
5. Click **Done**.
6. Click **Add an Image**
7. In the **Image Selection** window, specify the image to upload.
8. Click **Done** and return to the section.
9. Verify the details in the section and click **Done**.

Creating a Section with an Internal Video

1. On the **Author Tutorial** page click **Add a Section with Video** link. The Add window appears over the Author Section page.
2. Click **Search Learning**.
3. Enter a keyword or the video title, Benefits of Working at Vision Corporation and click search.
4. Preview the video and click **Select**. The video title and description automatically appear in the tutorial section title and description. Review the video title and description and edit them if required.
5. The source link is automatically indicated in the section. Verify the details in the section and click **Done**.

**Tip:** You can reorder the sections in the tutorial table of contents by dragging the tiles.

6. Click **Save and Close**.
You have now created a public tutorial. You can verify if the tutorial is listed in the **My Learning** page. You can recommend the tutorial to the selected people or everyone. Accordingly, the tutorial now shows up in the **Contributions** and **Recommendations** content areas of the **My Learning** page.

## Social Networking with Learning: Explained

If the course, specialization, or offering details page has a **Social** pane, you can invite others to collaborate about the learning item using social collaboration. Conversations remain within the learning item as a historical record.

Examples of collaboration:

- Instructors and learners collaborate on a learning assignment.
- The learner initiates a discussion with other learners to share information about their experience in an offering.
- Community members collaborate and discuss the learning items in the community catalog or assignments.

### Collaborating on Learning Items

**Tips for collaborating:**

- Use the **Social** pane in the course, specialization, or offering details page. Click **Share** or click **Join** if collaboration has already begun.
- Use the **Conversations** content area in the Communities Details page to watch and participate in community social conversations.
- Click the name of the learning assignment to access its wall and start conversations and add members.
- After collaboration starts for a learning item:
  - Other learners can only participate in conversations after being invited as a member.
  - Learners and instructors can initiate conversations and invite members.
  - On the wall of the learning item, everyone invited can view basic attributes of the learning item and post documents and comments that all members can see.

### Related Topics

- What does social networking have to do with my job?
- Who is the administrator of the community conversations?

### FAQs for Social Learning

**What's the difference between a video and a tutorial?**

A video is a type of media content that is recommended to other learners.

A tutorial is a collection of multiple pieces of mixed-media content that is specific to a particular topic.

The video tile has a **Play** icon while tutorial has a **View** button.
The video or tutorial content can be self-authored or authored by others.

What happens if I don't view a required video by the deadline?

The learning item in your queue becomes past due and the application sends you a notification.
3 Employee Self-Service

What to Learn Page: Explained

On the What to Learn page, you can view your own required or recommended learning, or search for learning items by keyword. On the My Learning page, you can also review your viewing history and the content you have published or recommended. On either page, you can share your knowledge by publishing videos or tutorials. To access these learning pages, select About Me and then Learning on the home page.

Collaboration Features

You can see how many likes, views, and recommendations each learning item has received, to help you choose which ones to view. The actions you can take for an item are:

- Like
- Recommend to an individual or group, with a short note
- Report inappropriate content, to notify your administrator
- Share in Oracle Social Network to start a discussion

Publishing

You can enhance your reputation as a subject matter expert by publishing videos or tutorials. You control the visibility of your video or tutorial, publishing to everyone or to a selected audience, such as an organization.

Related Topics

- Publishing a Video: Procedure
- Authoring a Tutorial: Worked Example

My Learning Page: Explained

As a learner, all your learning is tracked on the My Learning page. Your learning assignments, recommendations, published items, your viewing history, and your communities information is presented to make informed decisions.

The My Learning page has the following tiles and content areas:

- Current Learning
- Requested Learning
- Past Learning
- Contributions
- Communities
- Recommendations
Your manager or anyone in your management hierarchy can view all aspects of your learning in the My Learning page, excepting your viewing history.

Your coworkers can view your published learning, your communities to which they belong or manage, and your recommendations.

Current Learning

The Current Learning tile shows the number of overdue assignments. Review your Required Learning and Voluntary Learning assignments including the recently completed learning items, in progress, not started, and upcoming items. Each learning item shows the item name, item type icon, the name of the person who assigned the item (for required assignments), the number of days in which it has to be completed or is overdue (for required assignments), and the duration remaining to complete (if this information is available). You can start or resume learning from here. The required learning assignments appear in the following order:

- Overdue
- Upcoming
- Completed

Requested Learning

The Requested Learning tile shows a number of requested learning items. The requested learning items are listed in the Requested Learning content area sorted by the most recently requested date first. It includes details such as requested date, requested status, and the target learning period. You can modify your request and submit it again. You can cancel your learning requests.

Past Learning

The Past Learning tile shows learning items you have previously completed. Each learning item row includes title, date when it was completed, and the actual effort. You can search for your past learning items by keyword, completion date, and completion status. You can use the saved searches given in the application:

- Completed Assignments Only
- Required Learning
- Voluntary Learning
- Withdrawn Assignments Only

Contributions

The Contributions tile shows the number of learning items you have published. Each learning item card includes the number of views, the number of times it was recommended. If you hover over the thumbnail of item, it shows the duration of the video or the number of sections in the tutorial. You can recommend the learning item from the card itself or drill down to the Learning Item Details page and perform other actions such as Like, Recommend, or Require. You can edit the learning item and modify it. You can search for learning items by keywords or creation date. You can also use the saved search items in the application:

- Videos
- Tutorials
- Created in the Last 30 Days
Note: If you haven’t published any learning items, no learning items appear in the Contributions content area.

Communities

The Communities tile shows the number of learning communities you have joined or manage. The communities you manage or are a member of are tracked in the Communities content area. You can keep track of any communities where your join request is pending approval. Click on the community name in the card to open the Community Details page. In the Managed Communities section, to open the community in manage mode, click Manage Community.

Recommendations

The Recommendations tile shows the number of recommendations you have provided to others. The content area shows you the items you have recommended and the learning items recommended to you appear in the Recommendations content area. In the case of Items Recommended to you, the learning items appear in cards with the name of person, who recommended it to you, their recommendation note, title, learning item type icon, number of times the item was recommended and the number of likes it has received. You can further recommend the learning item to other learners. In the case of Items Recommended by you, the case show the card shows you the learning item thumbnail, the title, the learning item type icon, and how many people you have recommended this item to. You can click the Recommend icon on the card to recommend it again.

Related Topics

- Creating a Learning Community: Procedure
- My Learning Communities: Explained
- Recommending a Learning Item: Procedure
- Authoring a Tutorial: Worked Example

Searching for Learning Items: Explained

In the What to Learn page, you can search for learning items, people, communities in the search box. You can search for learning items based on the learning type such as video and tutorials.

Search Options

As you enter the search term, matching learning items are suggested in the search box. You can:

- Select and view the item.
- Click the More link under a category and view all the items.
- Click the Search icon or press Enter to view the full set of search results, sorted by publication date, in the List or Grid view.
Request Learning Item: Procedure

You can configure a learning item to require approval for registration. Learners and managers come across such a learning item, they submit a request for the offerings, courses, or specializations. When a request is approved and is set to **Active**, learners find the **Start Learning** button on the learning item. Managers can request learning for their team members. The learning items may be considered as an approved request by default. However, the administrator must set it to Active for the learner to start learning.

Request Learning for Learning Items in Learning Catalog

As a learner, you can request a learning item by doing the following steps:

1. Search for and select the learning item. It can be an offering, course, or a specialization.
2. In the **Learning Item Details** page, select **Request Learning**.

   **Note:** If you find the **Start Learning** button, you can start learning immediately.

3. For a course, the offerings in the course are listed by offering type. You can choose the entire course first and then the offerings within the course later. Else, you can selectively choose offerings in the course. Select the course or offerings you want to request for learning.
4. You can specify your training needs in the **Request Learning** page. The title and learning item type appear in the page.
5. Select the date you want to **Start After** and **Complete By**.
6. Enter the **Justification** for learning enrollment.
7. Click **Submit**.

You can cancel your learning request from learning item details page.

The administrator reviews the learning request and then approves or rejects it in the **Learners** page **Learning Assignments** tab in the Administrator work area or in the **Learners** content area of the learning items details page. After approving the assignment, the administrator must activate the assignment. The learner can then start learning.

The manager can track the team’s requested learning in **My Team** page, **Requested Learning** region. Learners can track their requests in the **Requested Learning** content area of **My Learning** page.

Request Learning Item: Procedure

You can configure a learning item to require approval for registration. Learners and managers come across such a learning item, they submit a request for the offerings, courses, or specializations. When a request is approved and is set to **Active**, learners find the **Start Learning** button on the learning item. Managers can request learning for their team members. The learning items may be considered as an approved request by default. However, the administrator must set it to Active for the learner to start learning.
Request Learning for Learning Items in Learning Catalog

As a learner, you can request a learning item by doing the following steps:

1. Search for and select the learning item. It can be an offering, course, or a specialization.
2. In the Learning Item Details page, select Request Learning.

   ✍️ Note: If you find the Start Learning button, you can start learning immediately.

3. For a course, the offerings in the course are listed by offering type. You can choose the entire course first and then the offerings within the course later. Else, you can selectively choose offerings in the course. Select the course or offerings you want to request for learning.
4. You can specify your training needs in the Request Learning page. The title and learning item type appear in the page.
5. Select the date you want to Start After and Complete By.
6. Enter the Justification for learning enrollment.
7. Click Submit.

You can cancel your learning request from learning item details page.

The administrator reviews the learning request and then approves or rejects it in the Learners page Learning Assignments tab in the Administrator work area or in the Learners content area of the learning items details page. After approving the assignment, the administrator must activate the assignment. The learner can then start learning.

The manager can track the team’s requested learning in My Team page, Requested Learning region. Learners can track their requests in the Requested Learning content area of My Learning page.

Request Noncatalog Learning Item: Procedure

Managers and Learners can request new catalog items. If you search for a learning item find no results, you can use the Request Noncatalog Learning task to add a learning item.

Request Noncatalog Learning

As a learner, you can request a learning item not in the catalog by doing the following steps:

1. From the Learning page, click the Actions menu and select Request Noncatalog Learning.
2. Enter a title for the learning item. This may not be the final title of the course, but provides a guideline for subject matter and target audience.
3. Optional: Enter a Description that clearly defines the content you have in mind.
4. Optional: Provide an estimate for the Expected Training Hours.
5. Optional: Enter a Price estimate and select a Currency.
6. Optional: Indicate the target date you want to Start On or After and Complete By.
7. Optional: Enter Comments for your request.
8. Click Submit.
9. Click OK to acknowledge successful submission of the request.

The learning request routes to the appropriate party for approval, who may be a learning administrator, representative, or other party, as designated in system rules. If the request is approved, when a new learning item is added to the catalog and activated, the learner can start learning.
A manager can track the team’s requested learning on the My Team page. Learners can track their requests from Requested Learning on My Learning page.

Enrolling Yourself in Learning Items: Procedure

When you come across learning items that may help you grow and aid in reaching your goal, you can register for a course, offering, or specialization. Registering for a course doesn’t register you for the offering. So you need to register for an offering separately later.

1. From the What to Learn or My Learning pages, search for and select a course or specialization.
2. Review the details and click:
   - Join to register for a specialization
   - Start Learning to register for a self-paced learning item
   - Register to register in an instructor-led training offering

✏️ Note: If you don’t find the Start Learning button, it indicates that no offerings are currently available.

The Voluntary Learning card in the What to Learn and My Learning pages tracks your personal learning items you have registered for.

Completing an Evaluation: Procedure

Evaluation is displayed automatically after you complete an offering. For an instructor-led offering, evaluation is displayed when you mark the offering complete or you will have the action to complete the evaluation in case you are unable to mark yourself complete. If you aren’t required to complete an evaluation for an offering, then you can mark yourself complete. You can submit an evaluation only once so ensure that you review the response before submitting.

To complete and submit the evaluation:

1. Complete the evaluation.
2. Click Submit. A notification is displayed indicating that the evaluation has been completed.

Courses and Specializations for Learning Outcomes: Worked Example

Learning results in certain outcomes. When these outcomes are specified in the courses and specializations, you can review the outcome details to determine if the outcome will benefit you based on your talent profile, current job, or job you have identified in your career path. When you complete the course or specialization, these outcomes will be added to your talent profile.

This example shows how to find courses or specializations that deliver specific learning outcomes and review the benefits. In this example, you look for courses to improve your French language skills.
Finding Courses and Specializations for Learning Outcomes

To search for courses that deliver a specific outcome:

1. Click Navigator > About Me > Learning.
2. On the What to Learn page, enter a keyword related to the learning outcome in the search box. Courses and specializations with this learning outcome appear in the search results.
3. Select the course and click the Learning Outcome Details link on the course details page.

In a specialization and click More Actions and then Learning Outcome to view the learning outcomes.

In the Skills and Qualifications window you can find the What You Will Achieve region. The area will identify if the outcome benefits you based on what you have in your talent profile, current job, or job in your career path. Check the learning outcome for French in the Languages region. Review the proficiency details for the French language. You can find the Reading, Writing, and Speaking levels. The ability to teach and translate the language is also specified.
4. Click OK to return to the course or specialization.

If you enroll and complete the course or specialization, your talent profile reflects the specified speaking, reading, and writing skills in French that were associated to the course or specialization.

Related Topics

- What’s a competency gap chart?

FAQs for Employee Self-Service

What's the difference between required learning, voluntary learning, and recommended learning?

Required learning consists of learning items assigned by a manager to be completed within a specific date. For example, your manager may consider a particular video relevant and mandates the training to the whole team. If you don’t complete the training in the specified period, it’s listed under your Overdue items.

Voluntary learning consists of learning items that don’t have a required completion date. It includes courses or specializations in which you enrolled yourself, and items your administrator enrolled you in, without a due date.

Recommended learning consists of learning items assigned to you by anyone. These learning items are not mandated and you can dismiss them. One or more people can recommend a learning item, and you can view their names on the learning item card.

Both your required and voluntary learning is tracked on the What to Learn and My Learning pages separately with crucial details that help you to organize better. The number of Likes and Views on the learning item card indicate the popularity of the item. The learning items in the Voluntary Learning card or Required Learning card indicate the status of learning and enable you to resume or start or restart your training accordingly.
How can I withdraw from an offering, course, or specialization?

Click More Actions, select Withdraw on the offering, course, or specialization details page. Select the withdrawal reason and specify comments in the Withdrawal window. You can’t withdraw from required learning items or items that you have already completed.

How can I complete an offering?

Click Mark as Complete when you complete an offering provided there is no required evaluation for the offering. This is applicable for instructor-led online, instructor-led on site, and self-paced offline offerings. For offerings with required evaluation you can’t mark yourself complete until you complete and submit the evaluation.
4 Manager Self-Service

Promoting Learning to Your Team: Points to Consider

You can require or recommend learning items to your team, to help them stay up-to-date and remain compliant. You can also encourage your team members to publish videos and tutorials to share best practices.

To access these learning pages, select My Team > Learning on the home page.

Required and Recommended Learning

On the What to Learn page, you can browse published learning items. When you find items of value to your team, you can:

- Recommend videos and tutorials to individuals or teams, with a short note to encourage them to view.
- Require completion of the videos by an individual or team. You can set a due date and include a short note.

You can only recommend or require public learning items. If the author restricted visibility to a set of users, the Recommend and Require links are not available for that item.

Tracking Completion of Learning

Use the My Team’s Required Learning page to review the number of completed, incomplete, and overdue required learning items across your team. You can view an individual’s status on the learning item, the person who required the learning item, and the due date. Viewing options include:

- By due date
- By direct report
- Required by others

Publishing

Promote best practices in your team by encouraging subject matter experts and star performers to share their knowledge or techniques. Anyone can publish a video or author a tutorial, which is a sequence of items such as web pages, videos, or documents.

Related Topics

- Authoring a Tutorial: Worked Example
- Publishing a Video: Procedure

Recommending a Learning Item: Procedure

Share your knowledge by recommending learning items. You may want to recommend learning items to your team or your peers.
You can recommend a learning item to an individual or a group from the learning item card or learning item details page. To recommend an item, do the following:

1. From the learning item card or details page, click the **Recommend** icon.
2. In the **Recommend Learning** window, enter a note mentioning why you recommend the learning item.
3. Search for and select the people or groups to whom you recommend the learning item.
4. If you selected a team, you can exclude individual members of that team by clicking the **Exclude Anyone** link.
5. Search for and select the people to exclude.
6. Click **Submit**. You get a confirmation that the recommendation is sent to the selected people.

> **Note:** Your recommendations are listed in the **Recommendations** content area of the **My Learning** page, whereas the recommendations you received are made available on the **What to Learn** page.

The learning item cards on the What to Learn page show the number of views and likes, and the names of the people who recommended the items to you.

### FAQs for Manager Self-Service

**Can a learning item be required and recommended?**

Yes. A learning item can be set as required and recommended by the same person or you can set the learning item as required to certain people and recommend the same to others.
5 Learning Communities

Learning Communities: Overview

A learning community is a place where learning can be grouped around a particular topic or area of interest and shared or assigned to a distinct set of people known as the community members. The purpose of a community can range from collaborative communities created by employees or managers, to a more formal learning community with assignments.

A few examples of using the community are:

- A department head can create a community for the whole organization to help members acquire knowledge and focus on specific areas.
- A learning specialist can create a learning program and assign the learning item to members with a specific role and job.
- Domain experts can make the community a central place to distribute the latest learning items and participate in discussions related to their areas of expertise.
- Team leaders can enable the team to publish their insights and exchange interesting work-related articles, videos, and tutorials in a community.

As a community owner, you can establish your own brand and identity. You can give frequent updates or schedule periodic updates in your community. You can enable members to create and publish learning items. This is a more purposeful way to gather and share insights with each other. Curate your learning items and engage your community members. A community catalog can have any kind of learning items such as, offering, course, specialization, video, or a tutorial.

Learning communities contain a catalog of learning items, community members, and optionally you can create assignments.

Communities are mainly classified into two categories:

- Catalog Communities: Created and managed by learning administrators
- Self-Service Communities: created and managed by employees or managers. You can configure which employees, if any, have the ability to create self-service communities and which ones can leverage community assignments.

Catalog Communities

As a learning administrator, you can create and manage catalog communities in the Administrator work area from the Learning Catalog page Communities tab if you are granted the privileges. The catalog communities for which you have access will appear here. Self-service communities, even those you may be a member or a manager, will not appear here.

Self-Service Communities

Learners and managers have the ability to create and manage their own learning communities. However, even if they don’t have a community to manage, they can still participate in learning communities, created by other people, as members or managers.
Community Membership

Communities have three access levels controlling how the user can engage with the community:

- **Community Manager**: Allows you to manage the community catalog and membership. Additionally, distinct privileges control the ability to manage required members.
- **Voluntary Member**: Allows you to access the community’s learning catalog and discussion forum.
- **Required Member**: Allows you to access the community’s learning catalog and discussion forum. Additionally you receive assignments created within the community.

Community Catalog

The community catalog is where community managers can add learning items for the easy access of their community members. You can add any type of learning item to the catalog, including courses, specializations, videos, and tutorials. Additionally, as a manager of a community, you can publish self-service videos and tutorials on behalf of the community. You can add these items as though they were published by the community and not as an individual. In the community settings, community managers can enable the option for nonmanagers to contribute to the community catalog. (Voluntary members and Required members can search for and add learning items into the community catalog.)

Community Assignments

Community managers can create and manage required learning assignments on behalf of the community. When such assignments are created, only the required members of the community receive them. The community manager requires a distinct privilege to use this feature of the community, but when granted, it gives them the authority on the required members of that community regardless who added them. You can manage assignments within the community itself. If you are a learning administrator, you can manage the assignments in the Administrator work area similar to all other assignments. The required members can access their assignments directly from within the community itself, and also from their My Learning and What to Learn pages similar to all other assignments. Lastly, when the community creates community assignments, you can configure them in such a way that only the current required members receive them or you can include future required members, who are added to the community automatically.

My Learning Communities: Explained

On the My Learning page, Communities content area you can view and track the communities you manage and communities in which you are a member. Your communities are listed as cards in the following categories:

- **Communities Managed**: The communities you manage.
- **Communities Pending Join**: The communities where your join request is waiting for approval by the community manager.
- **Communities Joined**: The communities in which you are a member.

Communities with the latest activity or notifications are prioritized and listed first. Communities that are pending approval are ordered based on the join request date starting with the earliest one.
On each community card, the following key information is displayed:

<table>
<thead>
<tr>
<th>Community Card Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community Name</td>
<td>Name to represent the community</td>
</tr>
<tr>
<td>Branding Image</td>
<td>An image that signifies your community</td>
</tr>
<tr>
<td>Number of member requests</td>
<td>Drill down from here to the community Membership content area and review the membership requests.</td>
</tr>
<tr>
<td>Number of newly published learning items</td>
<td>Drill down to the community Catalog content area and view the items.</td>
</tr>
<tr>
<td>The learning type icon</td>
<td>Indicates if the learning item is a video or tutorial</td>
</tr>
<tr>
<td>&lt;Days&gt; added</td>
<td>Number of days since the item was added to the community</td>
</tr>
</tbody>
</table>

Note: The wrench icon on a community card indicates that you manage the community.

You can click the card to open the Community Details page and perform your community tasks.

Manage Learning Communities in Learning Administrator Work Area: Explained

To facilitate the administrative work, you can manage your learning communities in the Learning Administrator work area itself. In the Learning Catalog page, Communities tab, you can search for communities and view community member and assignment details.

Use the following readily available Saved Searches and review details in search results:

- Open Communities
- Recently Created Communities
- Communities with New Assignments
- Communities with Overdue Assignments

You can drill down from the community to the community details page and manage your community.

Create and Manage Communities
Creating a Learning Community: Procedure

You can create a learning community from the My Learning page.

1. From the Home page, select About Me and then Learning.
2. Click the My Learning tab and then click Create Community in the My Learning page.
3. Click Add Image and upload an image that works as a branding image for the community.
4. Enter the title and description of your community.
5. You can specify a video that works as a trailer to advertise your community.
6. Select the privacy option for your community:
   - An Open community enables any learner to search for the community, view its learning catalog, and join the community.
   - A Closed community enables any learner to search for the community, but not view the learning items. You can request to join and view the catalog.
   - A Secret community is accessible to only members and managers from My Learning page Communities content area. Secret communities can't be searched.

   **Note:** You can always modify the settings of your community later.
7. For member contributions, select one of the following options:
   - Enabled: All the community members can publish learning items in the community.
   - Disabled: Only the community managers can publish learning items in the community.
8. Click Submit.

The new community is listed in the Communities Managed region of the My Learning page. Although, as the creator, you become the default community manager, you can add other managers on the Community Details page, in the Membership content area.

Managing a Community Catalog: Points to Consider

The community catalog stores and maintains learning items for a community. On each learning item card, you can view the item name, learning type icon, contributor name, and the number of likes.

Community members can drill down from the learning item card to the learning item details page and start learning.

Community Member Contributions

When member contributions are enabled for the community, any member of the community can search for existing learning items and add to the community catalog. They can also create videos and tutorials and add them to the community catalog.

The person who creates the learning item is the contributor. When a community manager creates and publishes a video or tutorial, the community name appears as the contributor on the learning item.

When member contributions aren’t enabled, only a community manager can add learning items to the community catalog.

In maintaining the catalog, the community manager can remove or delete learning items from the community catalog.

Related Topics
- Authoring a Tutorial: Worked Example
Managing Community Membership: Points to Consider

On the Community Details page, Membership content area, community managers can track the community membership details. Search for members by their name, role, membership status, or by the person who added members to the community.

A community comprises the community manager, required members, and members. Multiple managers can exist in a community to share and delegate the work. If the manager is also a required member of the community, then he or she will receive the required assignments.

Membership Role

As a community manager, you can:

- Add and remove required or voluntary members to an open or closed community. Required members receive required assignments, which must be completed before the specified date.
- Approve and decline member requests on closed communities.
- Change community members to required community members, if they are your team members or people in your area of responsibility.
- Add existing members and required members as community managers.
- Add nonmembers as community managers. The application also includes them as regular members of the community.

Note: You can verify the role changes in the Membership content area.

Members can leave the community voluntarily at any time, whereas the required members can’t leave the community on their own.

Community managers can leave a community voluntarily, unless they are also required members.

Changing Community Member Roles: Points to Consider

As a community manager, you can change the membership role from member to required member and required member to member.

Changing Member to Required Member

When you can change a member to required member, the member must be your subordinate or in your area of responsibility. They receive all the required assignments from the community.

Changing Required Member to Member

When you can change any required member to a member, the member must be your subordinate or in your area of responsibility. The incomplete required assignments are withdrawn from the members.
Adding Manager Role
You can add an existing member or required member as a community manager to manage the community catalog, membership, and assignments. You can add nonmembers as community managers.

Note: A community must have at least one manager. The last manager can’t leave the community till you get another manager.

FAQs for Learning Communities

Where can I view my recommended communities?
My community recommendations are tracked in the Recommendations content area of the My Learning page. Whereas communities recommended to me appear in the What to Learn page.

Who can recommend a learning community?
The community member, community manager, and nonmember can recommend a community. Only secret communities can’t be recommended.

How does a closed community appears for a nonmember?
The community shows only the branding image, trailer, and the community description. You will find the Join button to send your join request.
You can’t view the learning items and community conversations. To join the community, the community manager must approve the joining request and add you as a member.

What happens after I join a community?
Joining open communities is immediate whereas joining closed communities requires the community manager’s approval.
On becoming a member of a community, the community appears in the My Communities content area. You can view the community catalog or join the social conversations. You will receive required learning assignments, if any.

Who can view learning items in a community catalog?
If your community is open, everyone can view it. Only members can view the learning items in a closed community or a secret community.
What happens if I change the privacy setting of a community?

You can change the privacy setting of a community from open to closed and closed to open. The change impact is as follows:

When you change a closed community to open:

- Everyone can view the community.
- All the pending join requests to the community are automatically approved and the learners who requested to join the community are added as members.

> **Note:** You can't reopen requests that were earlier rejected, but you can try joining the open community again.

- Anyone can now view the community catalog.

When you change an open community to closed, anyone can search and find the community but only community members can view the community details.

Secret communities are similar to closed communities but can't be searched. Only the members and community managers can access the community.

Can a community manager change the membership role between member and required member?

Yes, if the community manager has the data security privileges on the community member.

What's the difference between removing and deleting a learning item in the community catalog?

Both actions remove the learning item from the community catalog.

After removing a learning item, you can still search for it, for example on the What to Learn page. However, deleting removes the learning item from the application completely.

Deletion requires confirmation to ensure you don’t eliminate learning items by mistake.

Community managers can remove any learning item from the catalog. However, they can’t delete learning items published by the community. However community members can only remove learning items they added.

What happens if a community manager removes a required member?

You will no longer find this community listed as your community in the My Learning page Communities content area. All the incomplete community assignments are withdrawn for the person.
How can I remove the community manager role for this member?

From the community Membership content area **Member Results** table select the person and click **Manager Role**. Deselect the Community Manager check box in the **Change Manager Role** window.
6 Courses

Learning Components: How They Work Together

Configure the learning components such as courses, offerings, specializations, and content, to deliver and manage learning in your enterprise.

Learning Catalog

The catalog is a virtual container for courses, offerings, and specializations.
The following figure illustrates how the learning content for Communication course uses multiple offerings and courses in a specialization and how all these fit together in the learning catalog:

- Courses contain generic information about the learning item such as long description, training objectives, and cover art. You include specific details such as delivery format and enrollments in offerings that you create for the course.
- Offerings are specific instances of a course, in which learners enroll. You can create one or more offerings for a course; Learners can search for and enroll in an offering suited to them. Learners complete the course when they complete any one offering pertaining to the course.
- Specializations are a set of courses grouped together in a logical order. You can search for existing courses and add them to a specialization.
Learning Content
You can import and upload learning content to your content server and deliver the content to learners through online offerings. The application supports the following content types: PDF, web link, video, and any content that adheres to the SCORM and AICC industry specifications.

Learner Assignments and Enrollments
You can assign and enroll learners to an offering and specify whether the assignment is voluntary, required, or recommended. Learners can enroll themselves from the self-service pages, which they can access by selecting About Me > Learning.

Related Topics
- Offerings: Explained
- Specializations: Explained
- Learning Content: Explained
- Managing Learners: Procedures

Courses: Explained
A course is an entity in the learning catalog that holds generic information about the learning. Courses contain information common to all offerings and save you from entering the same information in each offering of the course. To create and manage courses, select My Workforce > Learning > Learning Catalog, then select the Courses tab.

Start and End Dates
You can:
- Manage the course in the catalog only between the start and end dates. Learners can access the course only between these dates.
- Schedule offerings for a course only after the course start date and before the course end date. You may want to decide the course dates based on the offerings you plan to schedule for the course.
- Include a course in a specialization only if the course start and end dates are within the specialization start and end dates. When you search for courses to add to a specialization, the search results display only those courses whose dates fall within the specialization start and end dates.
- Automatically create a course and an offering for any content by selecting the content in the Manage Catalog Resources page and click Create in the Catalog Items Using the Content region. You can then define the course and offering.

Course Description
Learners see this description on the Course Details page, which they can access by selecting About Me > Learning.
Duration and Effort
You can specify the course duration and effort, for example, 5 days and 8 hours a day. This data is for information purposes only, and isn’t used to determine the offering dates or duration.

*Related Topics*
- Creating an Offering and Activity: Worked Example
- Creating a Specialization: Worked Example

Creating a Course: Worked Example
This example demonstrates how to create a course in the learning catalog.

Prerequisites
1. If you want to include a course cover, create the image and save it in any local folder.
2. If you want to include a trailer video, publish the video so that it’s available under My Published Videos.

Creating a Course
1. On the Home page, click **My Workforce > Learning > Learning Catalog** to open the Learning Catalog page.
2. Click **Courses**.
3. Click **Create**.
4. In the **General Information** tab complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Communication</td>
</tr>
<tr>
<td>Syllabus</td>
<td>This course aims to help you develop effective business communication skills.</td>
</tr>
<tr>
<td>Start Date</td>
<td>8/1/2016</td>
</tr>
<tr>
<td>End Date</td>
<td>8/1/2017</td>
</tr>
<tr>
<td>Privacy Options</td>
<td>Select <strong>Open</strong> and the course appears when you search and anyone can view the course details and content.</td>
</tr>
<tr>
<td>Minimum and Maximum Training Hours</td>
<td>16 and 24</td>
</tr>
<tr>
<td>Price</td>
<td>250 USD</td>
</tr>
</tbody>
</table>
5. In the **Cover Art** field, click **Add Cover Art**.
6. Select the course cover art image from your local folder and click **Done**.
7. In the **Trailer** field, click **Add Trailer**.
8. Click **My Published Videos**.
9. Locate your video and click **Select**. You can view the selected trailer in the course page.
   You can add learning outcomes such as Licenses and Certifications, Competencies, and Languages for the course in the **Learning Outcomes** tab.

**Note:** If you configure and deploy the flexfields for courses, you can use them to define and track organization-specific information. You can specify them on the **Additional Attributes** tab of the course page. Learners can view them on their course details page.

10. Click **Save and Close**. You can view the created course in the Course Details page with the **Definition, Offerings, Learners, Social** tiles and their content areas.

**Related Topics**
- Configuring Flexfields: Overview
- Profile Options for Learning Features: Explained

### Learning Outcomes: Explained

Learning outcomes are specific skills, qualities, or qualifications that a learner acquires on completing a course or specialization. Use the **Manage Catalog** page in the Learning work area to search, add, and manage learning outcomes.

Learning outcomes are a combination of the following components:

- Content Types
- Content Items
- Rating Models
- Person Profile

The Learning library has predefined content types such as Languages, Competencies, and Licenses and Certifications. When you configure a predefined content type, the content items, rating model, and task flow associated with that content type are also available.

### Content Types

Content types are the skills, competencies, or qualifications that you add as learning outcomes. You select a predefined content type or you create custom content types and configure them as learning outcomes. Use the **Manage Content Types** task in the Setup and Maintenance work area to create custom content types. Select Learn as the subscriber.

### Content Items

Content items are the individual qualities or attributes within the content type. You select a content item when you add the content type. For example, within the Competencies content type Leadership is a content item. Use the **Manage Content Items** task in the Setup and Maintenance work area to create content items for the content types.
Rating Models
Rating models measure the level of proficiency or skill for the content item. You select a rating model based on the content type you add. For example, choose a rating model that includes reading, writing, and speaking proficiency for the Language content type. Use the Manage Profile Rating Models task in the Setup and Maintenance work area to create rating models.

Person Profile
Person profile includes existing profile data such as learner skills, qualifications, and future job preferences. Learners view learning outcomes when they enroll for a course or specialization. They can see the direct benefits to their profile, job, and future job aspirations. When learners complete a course or specialization, their person profiles are automatically updated to reflect the learning outcomes.

Related Topics
- Profile Types: Explained
- Content Types: Explained
- Content Items: Explained
- Rating Models: Explained

Content Types for Learning Outcomes: Examples
These examples illustrate how to add and configure predefined content types such as Language, Competencies, and Certification to an existing course. You add content types as learning outcomes on the Learning Outcomes tab accessed from the course or specialization page in the Manage Catalog page.

Each of the predefined content types contain related fields also called content type properties. You only need to add the content type and choose the related values. You add the content types when you create a new course or specialization or add it later when required.

Configuring Competency Content Type
To add the Communication competency to a Marketing Communication course, you select the values shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competency</td>
<td>Communication</td>
<td>Indicates the quality or attribute assessed through the competency.</td>
</tr>
<tr>
<td>Proficiency</td>
<td>Advanced</td>
<td>Indicates the proficiency that is achieved for the competency.</td>
</tr>
</tbody>
</table>
A learner who completes this course acquires Advanced proficiency for the Communication competency.

Configuring Language Content Type

To add the Language competency to the Advanced French Language course, you select the values shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>French</td>
<td>Indicates the language being assessed through the course.</td>
</tr>
<tr>
<td>Reading</td>
<td>Advanced</td>
<td>Indicates the reading proficiency the learner achieves through the course.</td>
</tr>
<tr>
<td>Writing</td>
<td>High</td>
<td>Indicates the writing proficiency the learner achieves through the course.</td>
</tr>
<tr>
<td>Speaking</td>
<td>Advanced</td>
<td>Indicates the speaking proficiency the learner achieves through the course.</td>
</tr>
<tr>
<td>Native</td>
<td>No</td>
<td>Indicates that French is not the native language of the learner.</td>
</tr>
<tr>
<td>Able to Translate</td>
<td>No</td>
<td>Indicates that the learner doesn't achieve proficiency to translate.</td>
</tr>
<tr>
<td>Able to Teach</td>
<td>No</td>
<td>Indicates that the learner doesn't achieve proficiency to teach.</td>
</tr>
</tbody>
</table>

A learner who completes this course acquires Advanced reading, writing, and speaking proficiency in French. The course doesn't provide the proficiency to translate or teach.

Configuring Licenses and Certifications Content Type

To add the Certification competency to the Safety Hazards Recognition Program, you select the values shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Safety Hazards Recognition Program</td>
<td>Indicates the title of the course.</td>
</tr>
<tr>
<td>Renewal Required</td>
<td>Yes</td>
<td>Indicates the certification needs to be renewed one year from the date of completion.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Renewal in Progress</td>
<td>No</td>
<td>Indicates renewal is not in progress since this is the first time the learner is taking the certification.</td>
</tr>
<tr>
<td>Number</td>
<td>Leave blank</td>
<td>When left blank indicates there is no previous score or credit earned by the learner for this certification.</td>
</tr>
</tbody>
</table>

Learners who complete the certification will see the issue date, expiry date, and renewal date on their profile.

**Related Topics**

- Content Items: Explained
- Content Types: Explained
- Rating Models: Explained
7 Specializations

Specializations: Explained

A specialization contains multiple courses grouped together as a single entity, to help learners achieve goals that a single course can’t address. To create and manage specializations, select My Workforce > Learning > Manage Catalog, then select Manage Specializations.

Specialization Details

You specify the following details for a specialization:

- **Title:** You may want to use a title that conveys the purpose of the specialization since the specialization includes multiple courses with different titles.
- **Start Date and End Date:** You can manage the specialization in the catalog only between the start and end dates. Learners can access the course only between these dates.
- **Status:** Can be either Active or Inactive. Learners can access the specialization either through their Current Enrollment or User History pages as long as the specialization status is Active.

Sections and Activities

A specialization contains one or more sections. A section is a container for a logical grouping of activities (courses). You must add a least one section in a specialization. You can select how many activities the learner must complete in a section:

- **Selecting All** means the learner must complete all the courses in the section.
- **Selecting 0** means the courses in the section are optional. A learner may select not to enroll in any of the courses in the section.

Create sections to provide a mixture of elective and mandatory courses in the same specialization.

A section contains one or more activities (courses). You can add activities to a saved section by searching for and selecting existing courses. When you search for a course, you can also see the number of active offerings available for the course.

You can reorder the sections in a specialization and the activities in a section to control how they appear to learners.

Enrollments

Use the Manage Learners page to view the learners currently enrolled in offerings of the courses included in a specialization. You can enroll additional learners by searching for and selecting people. Learners can enroll themselves from the Offering Details page, which they can access by selecting About Me > Learning.

Related Topics

- Learning Outcomes: Explained
Creating a Specialization: Worked Example

This example demonstrates how to create a specialization in the learning catalog. The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In this Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of sections? Number of mandatory activities in each section?</td>
<td>Three sections in the following order:</td>
</tr>
<tr>
<td></td>
<td>1. Project Management Basics (all activities mandatory)</td>
</tr>
<tr>
<td></td>
<td>2. Project Management Certification (no mandatory activities)</td>
</tr>
</tbody>
</table>

Prerequisites

1. To include a cover for the specialization, create the image and save it in any local folder.
2. To include a trailer video, publish the video so that it's available under My Published Videos.

Creating a Specialization

1. On the Home page, click My Workforce > Learning > My Catalog to open the My Catalog page.
2. Click Manage Specializations.
3. Click Create.
4. On the Create Specialization page, complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Project Management</td>
</tr>
<tr>
<td>Description</td>
<td>This specialization offers a series of courses to help you manage projects in your organization.</td>
</tr>
<tr>
<td>Start Date</td>
<td>8/1/2016</td>
</tr>
<tr>
<td>End Date</td>
<td>8/1/2017</td>
</tr>
<tr>
<td>Privacy Options</td>
<td>Select Open so that anyone can view the specialization details and content.</td>
</tr>
<tr>
<td></td>
<td>◦ Open</td>
</tr>
<tr>
<td></td>
<td>◦ Closed</td>
</tr>
<tr>
<td></td>
<td>◦ Secret</td>
</tr>
</tbody>
</table>

5. To add Cover Art, click Add Cover Art to upload the image.
6. Click Done to return to the Create Specialization page.
7. Select the specialization cover art image from your local folder and click Done.
8. To add a trailer, click Add Trailer.
9. Search for or click My Published Videos in the Add New Trailer page to select and add a video.
10. Click Select to specify the video and return to the Create Specialization page.
11. Click Save.

Adding Sections and Activities

1. Click the Sections tab.
2. Click Add Section.
3. In the Create Section window, complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Project Management Principles</td>
</tr>
<tr>
<td>Description</td>
<td>This section includes courses on principles of project management.</td>
</tr>
<tr>
<td>Number of Activities to Complete</td>
<td>All</td>
</tr>
<tr>
<td>Place Section After</td>
<td>This appears if you have more than one section in the specialization.</td>
</tr>
</tbody>
</table>

**Note:** Use this field to place the section in some position other than the last.

4. Click OK.
5. On the Sections page, to add a section, click Add Activity.
6. In the Add Activities window, enter Communication and click the search icon.
7. In the search results, select the Communication course.
8. The Place Activity After field appears when you have more than one activity in the section. Select the activity after which you want to place the current activity. Use this field only if you want to place the activity some position other than the last.
9. Click Add and Close.
   Add more sections and activities as required.
10. Click Save.

Adding Learning Outcomes

1. Click the Learning Outcomes tab to add content items such as Competencies, Languages, Licenses, and Certifications.
2. Click Add Content and then Competency content item. The Competencies region appears in the Learning Outcomes page.
3. Click Add and specify the Maintain Communication Competency and Foundation Proficiency for the Evaluation Type.
4. Click Save and Close. The specialization you just created appears with Definition, Learners, and Social tiles.
5. You can create assignments and add learners later too. Click Done to return to the Specializations page in Learning Catalog.
Related Topics

- Content Types for Learning Outcomes: Examples
- Profile Options for Learning Features: Explained
8 Learning Content

Learning Content: Explained

Content is online learning material that you deliver to learners through offerings. You add and manage learning content using the Manage Content page in the Learning work area under My Workforce.

Content Types

The content you add is imported and uploaded to the content server. You can add the following types of content:

- SCORM or AICC package: The content is in the XML format and packaged into a single .zip file format. During import, the application creates the content structure by reading the XML files that conform either to the SCORM (SCORM 1.2 or SCORM 2004 Edition 3) or AICC specification.
- Video
- Web link
- PDF

Content Statuses

After you add content, use the Status column on the Manage Content page to verify whether the content is uploaded. The content uses the following status values:

- New: The content is uploaded but the application hasn't processed it yet
- Processing: The content is uploaded and being processed
- Processing Failed: The application couldn't process the content. The reasons for failure could include inability to read the PDF file or web link, convert the video, or recognize the content as SCORM or AICC compliant.
- Active: The content is available for associating with an offering and delivering to learners
- Inactive: The content isn't available for associating with an offering

You can change the status of any active content to Inactive by selecting the content on the Manage Content page.

Related Topics

- Learning Initiatives: Explained

Importing and Uploading Learning Content: Procedure

If you want to use a SCORM or AICC video, PDF, and web link learning content, you must import it to the content server. Importing of videos and PDF is simple and straightforward. The administrator uploads a video or PDF file from a directory into the application. When the administrator uploads a web link, then define the name of the web link and enter the URL of the web link into the application.
The following procedure provides steps to load in SCORM or AICC content into the application.

Prerequisites
Ensure that the content is:

- SCORM or AICC compliant
- Packaged as a single .zip file

Importing SCORM Content
Perform the following steps:

1. On the Home page, select Learning under My Workforce and then select Manage Content.
2. Click Add Content and then click Add Online Content.
3. Select the content .zip file from your desktop. In the Import Content window, you can view the progress of the import.
4. Enter a title. If you don’t specify a title, the application uses the name of the content .zip file as the title.
5. Click Save and Close.

The application processes the content and uploads it to the content server. You can use the content only after it’s successfully processed and the status of the content changes to Active.

Verifying Content Upload
On the Manage Content page, search for the imported content and verify if the content is uploaded. Perform the following steps:

1. In the Search section, Keywords field, enter the title or any part of the title.
2. In the Status field, select All.

Note: The Active status is selected by default. If you don’t change the status value to All, you may not find your content because the content may not be in Active status immediately after import.

3. Click Search.
4. Locate your content in the search results and verify the value in the Status column. The initial status value is New and it changes to Active after the content is uploaded and ready for use. You may want to refresh the page periodically to view any status changes.
9 Offerings

Offerings: Explained

An offering is a specific instance of a course, in which learners enroll.

Offering Creation

You can create an offering in one of the following ways:

- From the Manage Courses page, create a course and then create an offering for the course
- From the Manage Offerings page, create an offering by searching for and selecting an existing course
- From the Manage Content page, create a course and offering automatically for the selected content

Offering Details

A course contains generic information such as title and duration. An offering contains specific details such as delivery mode, content, assignment, and enrollment.

- Description: Learners see this description on the Offering Details page, which they can access by selecting About Me > Learning.
- Status: You can set it to either Active or Inactive. Learners can enroll in the offering and access the offering content only when the offering status is Active.
- Delivery Mode: Indicates how the offering is delivered. Delivery modes are either online or offline and self-paced or instructor-led. You can specify different delivery details for each delivery method. For example, you specify content for online offerings and capacity details for instructor-led offerings.
- Start Date: Is the date on which the offering becomes visible to people in the catalog.
- End Date: Is the date until which the offering is visible to people in the catalog.
- Duration: The value is automatically populated if the content associated with the offering is a video. The duration is calculated based on the length of the video.

Capacity Management

For instructor-led on-site offerings:

- You can optionally specify the minimum and maximum number of seats. Specify these details to automatically prevent any new enrollments when the maximum is reached. The Add Learners button on the Manage Learners page is disabled. You can still recommend the offering to learners, but you can’t add voluntary or required assignments because these create enrollments. The Enroll button is disabled on the learner self-service pages.
- The Booked Seats field displays the number of learners currently enrolled in the offering, including learners in the following statuses: Not Started, In Progress, and Completed.
- The maximum number of seats can’t be less than the booked seats.
Offering Completion
You can enable learners to mark themselves complete for the following types of offerings: instructor-led on-site, instructor-led offline, and self-paced offline. If you enable this option, the Mark as Complete button appears to enrolled learners on the Course Details page. If learners are enrolled in multiple offerings of the course, they can mark themselves complete only for those offerings that have this setting enabled.

Content
If you select the self-paced online delivery mode for an offering, you must associate the offering with content available on your content server. To import and upload content to the content server, use the Manage Content page in the Learning work area.

Learner Management
From the Manage Learners page, you can add learners to an offering and classify the assignment as voluntary, required, or recommended. You can view the status of the assigned learners, for example how many learners have not started, are in progress, or have completed the offering. Learners can also enroll themselves from the Offering Details page, which they can access by selecting About Me > Learning.

Related Topics
- Learning Content: Explained
- Managing Learners: Procedures
- Learning Assignments: Explained
- Learning Initiatives: Explained

Defining an Offering and Its Activities: Explained
You can create an offering and associate it with a course from the following pages in the application:
- From the Offerings content area in the course details page. Edit a course to add an offering.
- From the Offerings tab in Learning Catalog. Create an offering for a course by searching for and selecting an existing course.
- From the Manage Catalog Resources page, select the content and create a self-paced offering or blended offering. You can then associate the offering with an existing course or create a course for the offering.
- From the Actions menu in the Administrator work area.

General Information
Specify the general information for an offering:
- Basic information such as the offering title and description, publishing dates, offered language. The application automatically creates the offering number.
- Capacity Rules: Specify the minimum and maximum number of attendees for the offering to prevent enrollments when the offering reaches the maximum. You can specify the offering price so that learners and learner managers
can estimate the training costs. The application indicates the booked seats so that you are aware of the occupied seats.

<table>
<thead>
<tr>
<th>Privacy Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>The offering appears in search results and anyone can view offering content and details</td>
</tr>
<tr>
<td>Closed</td>
<td>The offering appears in search results. Only learners who enroll or are assigned the offering can view offering content details.</td>
</tr>
<tr>
<td>Secret</td>
<td>The offering appears in search results only for those learners, who are assigned to the offering</td>
</tr>
</tbody>
</table>

Activities

Learners take an offering activity for a specific period online, offline, or on site, with or without an instructor.

You can create one or more activities for an offering. Based on the offering you create, you can create activities. Create instructor-led activities for an instructor-led offering and self-paced activity for self-paced offerings. For blended offerings, you can create any or all the following activities:

- Instructor-led activity: Represents a discrete live online or on site event lead by one of more instructors for a specific period within one day.
- Self-Paced activity: Represents work done by a learner online or offline or on site with no time constraints. However, learners still needs to complete the activity before the assignment due date, if it is specified in the assignment.

For self-paced activities, you associate the offering with content that is uploaded to Oracle Learning Cloud. If you add content to a self-paced activity, it becomes self-paced online. If you don't, it becomes self-paced offline.

This table provides the attributes you specify when you create different types of activities for the offering:

<table>
<thead>
<tr>
<th>Self-Paced Activity</th>
<th>Instructor-Led Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title</td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Not Applicable</td>
<td>Date and Time</td>
</tr>
<tr>
<td>Not Applicable</td>
<td>Time Zone</td>
</tr>
<tr>
<td>Expected Effort</td>
<td>Expected Effort</td>
</tr>
<tr>
<td>For the online activity, upload the content</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>For offline activity, you don’t need to upload any content.</td>
<td></td>
</tr>
<tr>
<td>Not Applicable</td>
<td>Instructor Names</td>
</tr>
</tbody>
</table>
You can enable the **Allow person completing the activity to mark themselves complete** option in the **Activities** tab of the offering. Then learners can mark themselves complete when they finish the activity. If learners are enrolled in multiple activities, then they can mark themselves complete only for those activities that have this option enabled.

Enable the **Evaluation** option for the entire offering and use the default questionnaire. If you don’t want the default questionnaire, you can override it and specify another one. To ensure a feedback from all learners, you can make the completion of the questionnaire compulsory for completion of the offering by enabling this option.

You can update, copy, and delete existing activities in an offering.

### Creating an Offering and Activity: Worked Example

This example demonstrates how to create an offering and offering activity for an existing course in the learning catalog. It also demonstrates how to enroll learners in the offering. In this example, the offering is a self-paced online offering called Communication Class with one activity, Effective Ways and Means of Communication. You want to make the offering required for all people in Ravi’s organization and enroll them in the offering.

#### Creating an Offering and an Activity

1. Click **Navigator > My Workforce > Learning > Learning Catalog** to open the **Learning Catalog** page.
2. On the **Offerings** tab, click **Create** and then **Self-Paced Offering**.
3. Search for and select the Communication course.
4. On the **Create Offering for Communication** page, complete the fields as shown in this table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Communication Class</td>
</tr>
<tr>
<td>Description</td>
<td>This offering focuses on how to communicate effectively in the workplace.</td>
</tr>
<tr>
<td>Offering Type</td>
<td>Self-Paced Offering</td>
</tr>
<tr>
<td></td>
<td>The Offering Number and Offering Type automatically appear.</td>
</tr>
<tr>
<td>Publish Start Date</td>
<td>1 September 2017</td>
</tr>
</tbody>
</table>
Field | Value
--- | ---
Language | American English
Privacy Options | Select Open so that the offering appears in search results. Anyone can view offering details and content.
Capacity Rules Minimum | 3
Capacity Rules Maximum | 9
Booked seats indicates the number of seats booked.
Price | 100 USD

5. Click **Save**.

6. Click the **Activities** tab to add an activity for the offering.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Communication Techniques</td>
</tr>
<tr>
<td>Description</td>
<td>An activity to learn ways and means of communication</td>
</tr>
<tr>
<td>Offering Content</td>
<td>Search for and select Effective Ways and Means of Communication</td>
</tr>
<tr>
<td>Expected Effort</td>
<td>6 Hours</td>
</tr>
</tbody>
</table>

7. Click **Save and Close**.

You have now created an offering with one activity.

Adding Learners to Communication Class Offering

1. On the Communication Class offering details page, click the **Learners** tile to view the **Learners** content area.
2. In the **Learner Results** section, click **Add Learners** and select **Required**.
3. In the **Required Learning** page complete the following fields as shown in this table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Communications Methods</td>
</tr>
<tr>
<td>Description</td>
<td>This assignment is to learn communication ways and means effectively in the workplace.</td>
</tr>
<tr>
<td>Start Date</td>
<td>1 September 2017</td>
</tr>
</tbody>
</table>
Field | Value
---|---
Assign As | Self

With this note: Mandating this assignment to all the members of my organization

Due Date | 30 September 2017

4. Click **Next** to add learners to the offering assignment.
5. Search for and select Ravi’s Organization.
6. Click **Submit**.
   An information message appears indicating that the learning assignment is created and processed for all the selected users.
7. Click **OK**.
8. Review the details of the offering and click **Done** to return to the **Offerings** page of the Learning Catalog.

### Learning Evaluation: Explained

Use evaluations to capture learner feedback about the offering that they have just completed. You can specify a default evaluation for each delivery method using the Manage Setup page in the Learning work area. You can override the default and associate a new evaluation at the offering level.

An offering can have only one evaluation associated with it and this evaluation is presented to the learner in the form of a questionnaire. The learner is taken automatically to the evaluation after the offering has been completed. For instructor-led training, the learner can complete the evaluation when they mark the offering complete or they will have the action to complete the evaluation if they are unable to mark themselves complete.

You can’t create or edit a questionnaire in the Learning work area, but you can associate and preview how it’s presented to the learner.

When you associate a default evaluation to a delivery method the same evaluation is presented for all learning content of that delivery type. It’s also possible to override this default evaluation by associating a offering-specific evaluation.

You can define an evaluation as required or optional:

- Required evaluations mean that the learner must complete the evaluation before the offering is considered complete.
- Optional evaluations mean that the learner will be marked as complete after they complete the offering content even though the evaluation hasn’t been completed.

The progress of the learner evaluation is displayed on the Manage Learners page. The results indicate whether the evaluation is complete, in-progress, withdrawn, or yet to start. To further understand the response to the evaluation, you can view the response of each learner in the offering.

**Related Topics**

- **Associating an Evaluation to Offerings: Procedure**
- **Learning Assignments: Explained**
10 Learning Assignments and Learning Initiatives

Learning Assignments: Explained

You can assign learners to a learning item and specify whether the assignment is voluntary, required, or recommended. Use the Manage Learners page to assign and manage learners.

Assignment Types

Assignment types include:

<table>
<thead>
<tr>
<th>Assignment Type</th>
<th>Automatic Enrollment</th>
<th>Completion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voluntary</td>
<td>Yes</td>
<td>Completion of learning isn’t mandatory. Learners can view the learning item in their Voluntary Learning section and choose to complete it.</td>
</tr>
<tr>
<td>Required</td>
<td>Yes</td>
<td>Completion of learning is a must. Learners can view who proposed the learning item and the due date of completion in their Required Learning section. The learner assignment status changes to Overdue if a learner doesn’t complete the learning item by the due date.</td>
</tr>
<tr>
<td>Recommended</td>
<td>No</td>
<td>Learners can view who recommended the learning item and choose to enroll in it. As the person creating the learner assignments, you are listed by default as the recommending authority.</td>
</tr>
</tbody>
</table>

Use the Assign As field to specify another name, such as Legal Department or Security Team.

Learner Selection

You can select learners for each assignment type either by searching for people or using an analysis report.

If you create an assignment for a learner who is already assigned to the same learning item, there may be a data conflict. The following examples illustrate some potential conflicts and the resolutions:

<table>
<thead>
<tr>
<th>Current Assignment Type</th>
<th>New Assignment Type</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended</td>
<td>Voluntary or Required</td>
<td>A second assignment (voluntary or required) is created</td>
</tr>
</tbody>
</table>
Learning Initiatives: Explained

An ongoing assignment is called a learning initiative. Unlike a learning assignment, which is applicable only once, you can create and define a learning initiative once and generate multiple assignments in a series with or without an end date. You can assign it to a group of learners in an organization by using an analysis report or an organization chart. For example, you can create a learning initiative for the Ethics and Business Conduct course and assign it to all employees when they join the organization. The initiative continually creates assignments to all the newly joined employees to complete the course in the specified duration and date.

The Evaluate Person IDs for Assignment Rule process and Reconcile Dynamic Assignments process verify for new learners or learners leaving the group to assign the assignments in the learning initiative.

Similar to assignment types, the following are learning initiative types:

- Voluntary learning initiative
- Required learning initiative
- Recommended learning initiative

You can create a learning initiative for an offering, course, or a specialization in the Learners content area of the learning item or from the Administrator work area Learners page Learning Initiatives tab.

Creating a Required Learning Initiative for Ethics and Business Conduct Course

The following example explains the steps to create a required learning initiative for the Ethics and Business Conduct course from the Administrator work area Learners page:

1. In the Learners page, Learning Initiatives tab, click Add Initiative > Required.
2. In the Assignment Details page, specify the following:

<table>
<thead>
<tr>
<th>Current Assignment Type</th>
<th>New Assignment Type</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voluntary or Required</td>
<td>Recommended</td>
<td>A second recommended assignment is created</td>
</tr>
<tr>
<td>Voluntary</td>
<td>Required</td>
<td>A second required assignment is created</td>
</tr>
<tr>
<td>Required</td>
<td>Voluntary</td>
<td>A second voluntary assignment is created</td>
</tr>
<tr>
<td>Required</td>
<td>Required</td>
<td>A learner can have only one required assignment at a time. The second assignment is rejected</td>
</tr>
<tr>
<td>Voluntary</td>
<td>Voluntary</td>
<td>A learner can have only one voluntary assignment at a time. The second assignment is rejected.</td>
</tr>
<tr>
<td>Recommended</td>
<td>Recommended</td>
<td>A second recommended assignment is created</td>
</tr>
</tbody>
</table>
## Oracle Talent Management Cloud
### Using Learning

**Chapter 10**

**Learning Assignments and Learning Initiatives**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Assignment for Business Ethics</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>This is a required assignment for the entire organization.</td>
</tr>
<tr>
<td><strong>Assign</strong></td>
<td>Search for and select the Ethics and Business Conduct Course</td>
</tr>
<tr>
<td><strong>Assign As</strong></td>
<td>Select <strong>Self</strong>. Learners will be able to view that you assigned the learning item to them. To assign it as someone else, use other values such as Office of the CEO, Security, Legal Department.</td>
</tr>
<tr>
<td><strong>With This Note</strong></td>
<td>Enter any text you want to display to learners with this assignment: Learn organization business ethics from this course.</td>
</tr>
<tr>
<td><strong>Initial Due Date Option</strong></td>
<td>Select <strong>Days</strong> in the list and enter 15. This 15 days due period is applicable to learners identified on the initiative start date.</td>
</tr>
<tr>
<td><strong>Ongoing Due Date</strong></td>
<td>For the other learners, who are the target of this initiative, specify 20 Days. Learners who take this course must complete the course within 20 days of taking the course after joining the organization.</td>
</tr>
</tbody>
</table>

3. Click **Next** to select learners.<br>4. In the **Select Learners** page, click **Add Learners** and then **Search and Select Organization Chart Group**.<br>5. Select the organization group and click **OK**.<br>6. Click **Next** to specify the **Advanced Rules** of the initiative.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Learning Item As-Of</strong></td>
<td>Select <strong>Latest</strong> in the list. The latest course content is available to learners when they take the assignment. You can select Initiative Start Date or Assignment to Learner Date to display the course as it is on these dates.</td>
</tr>
<tr>
<td><strong>Validity Period Options.</strong></td>
<td>Select <strong>After Completion</strong> so that the assignment completion is valid immediately after completing the assignment and not after the due date.</td>
</tr>
<tr>
<td><strong>Expiration</strong></td>
<td>Select <strong>Expires in Years</strong> and select <strong>Every Two Years</strong>. You must provide renewal option when you set an expiry for the course.</td>
</tr>
<tr>
<td><strong>Renewal Options</strong></td>
<td>Select <strong>After Completion</strong> in the list so that the course assignment is renewable only after completion.</td>
</tr>
<tr>
<td><strong>Learner Reconciliation</strong></td>
<td>This is a learning initiative-specific option. You can reconcile the learners with the assignments for the initiative&lt;br&gt;Select the check box to withdraw assignments of learners, who are no longer a part of this learning initiative.</td>
</tr>
</tbody>
</table>
7. Click **Submit**. If the initiative processing is successful, you get a confirmation that the initiative is created and sent to the recipients.

## Rules for Learning Assignments and Learning Initiatives: Explained

You can make use of assignment rules and specify them as per your requirements when creating a learning assignment or learning initiative. The rules are related to the learning item form, validity, expiry, and renewal, which you can specify in the **Advanced Rules** tab of a learning assignment or learning initiative.

Consider and define the following options when you create or edit a learning assignment or learning initiative:

<table>
<thead>
<tr>
<th>Assignment Rules</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Learning Item As-Of Date</strong></td>
<td>Learning item can be continuously updated and improved. Choose to assign the learning item as on:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Latest</strong>: The latest form of learning item</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assignment to Learner Date</strong>: The form of the learning item as on the date it was assigned to the learner</td>
</tr>
<tr>
<td><strong>Validity Period Options</strong></td>
<td>Enables you to specify how and when the assignment completion becomes valid:</td>
</tr>
<tr>
<td></td>
<td>• <strong>After Due Date</strong>: The assignment becomes valid after the due date of the assignment. For example, the learner completes the assignment ahead of the due date, the assignment is considered valid only after the due date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>After Completion</strong>: The assignment becomes valid immediately after completion of the assignment. For example, the learner completes the assignment ahead of the due date, the assignment is considered valid immediately after the completed date that is ahead of the due date.</td>
</tr>
<tr>
<td><strong>Expiration</strong></td>
<td>Expiry is calculated from the assignment validity date. Select one of the following assignment expiry options and specify the details:</td>
</tr>
<tr>
<td></td>
<td>• Expires on a specific date</td>
</tr>
<tr>
<td></td>
<td>• Expires in years</td>
</tr>
<tr>
<td></td>
<td>• Expires in days</td>
</tr>
<tr>
<td></td>
<td>• Never expires</td>
</tr>
<tr>
<td><strong>Renewal Options</strong></td>
<td>The learner will get a repeat of the assignment based on the renewal option. Select one of renewal options, if the assignment expires:</td>
</tr>
<tr>
<td></td>
<td>• <strong>After Completion</strong>: Learner gets the repeat of the assignment after the completion date</td>
</tr>
<tr>
<td></td>
<td>• <strong>After Due Date</strong>: Learner gets the repeat of the assignment after the due date</td>
</tr>
<tr>
<td></td>
<td>• <strong>Before Expiry</strong>: Learner gets the repeat of the assignment certain days before the expiry of the assignment</td>
</tr>
<tr>
<td><strong>Learner Reconciliation</strong></td>
<td>The option is applicable to learning initiatives only.</td>
</tr>
<tr>
<td></td>
<td>Select the option to reconcile learners for assignments by withdrawing incomplete assignments from people, who have moved away from the organization or who are not in the analysis report.</td>
</tr>
</tbody>
</table>
Assignment Statuses: Explained

Assignment statuses help you track and control the progress of learners. Assignment statuses include:

<table>
<thead>
<tr>
<th>Assignment Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed</td>
<td>Indicates that a learner has completed all the required components of the learning item. The application automatically sets the status of the learner to Completed. You can also manually set the status of a learner to Completed. You can’t revert the change after it is set to Completed or to any other status.</td>
</tr>
<tr>
<td>Content Complete</td>
<td>Indicates that learning was completed for the offering but the mandatory evaluation is pending</td>
</tr>
<tr>
<td>In Progress</td>
<td>Indicates that the learner has started at least one component of the learning item</td>
</tr>
<tr>
<td>Not Started</td>
<td>Indicates that the learner hasn’t started any of components of the learning item</td>
</tr>
<tr>
<td>Withdrawn</td>
<td>Indicates that the learner is withdrawn from the enrollment of the learning item. A withdrawal is possible for those learners whose assignment status is either Not Started or In Progress.</td>
</tr>
<tr>
<td>Requested</td>
<td>Indicates that a learning request is made for an assignment to a learning item</td>
</tr>
<tr>
<td>Request Approved</td>
<td>Indicates that the learning request (not the learning assignment) is approved</td>
</tr>
<tr>
<td>Request Rejected</td>
<td>Indicates that the learning request is rejected</td>
</tr>
<tr>
<td>Deleted</td>
<td>Indicates the learner is deleted from the assignment. After deleting, the assignment doesn’t show up in the learner’s transcript.</td>
</tr>
</tbody>
</table>

Creating a Learning Assignment: Procedure

You can create learning assignments from the Learners content area in a specialization, course, and an offering or the Learners page in the Administrator work area. You can create voluntary, required, or recommended assignments and assign it to learners by searching for people or using an analysis report or an organization chart. Manage learners and their assignments by doing the following:

- Activating assignments
- Deleting assignments
- Approving requests
- Rejecting requests
- Marking assignment completion for learners
- Withdrawing learners from assignments
Creating a Required Assignment

This procedure details the steps to create a required assignment for an offering and assign the latest version of the learning item to learners using an analysis report.

1. On the Offering page, click the Learners content area.
2. Click the Learning Assignments tab.
3. In the Learner Results region, click Add Learners and select Required. The assignment creation page opens.
4. In the Assignment Details page, specify Name, Description, Start Date of the assignment.
5. In the Assign As field, select Self. Learners will be able to view that you proposed the offering to them. To assign it as someone else, use other values such as Office of the CEO, Security.
6. Use the With This Note field to enter any text you want to display to learners.
7. Enter Due Date
8. In the Select Learner By field, select Existing Analysis.
9. Click Next to select learners.
10. In the Select Learners page, Analysis Report field, search for and select an analysis report.
11. Click Preview and verify the names in the analysis report. If these aren’t the intended names, you can remove or change the report name.
12. Click Close.
13. Click Next to open the Advanced Rules.
14. Select Latest in the Learning Item As-Of list.
15. Select After Completion for Validity Period Options.
16. For Expiration select Never Expires.
17. Click Submit. If the assignment processing is successful, you get a confirmation that the assignment is sent to the recipients.

Managing Learners: Procedures

You can add learners to an offering either when you create an offering or later by selecting the offering on the Manage Offerings page. Use the Manage Learners page to add new learners and track the status of existing learners. Learners can enroll themselves in offerings from the Offering Details page, which they can access by selecting About Me > Learning.

Adding Learners

Perform the following steps to add learners to an offering:

1. On the Offering page, click the Learners tile.
2. In the Learner Results section, click Add Learners.
3. Select the type of assignment whether Voluntary, Required, or Recommended.
4. In the Assignment Details page, enter the details for the selected assignment type. In the Select Learners By field, specify whether to select learners by searching for named users or based on an existing analysis report or by organization chart.
5. Select learners either by searching for people or using an analysis report or by organization chart. You can select from a list of analysis reports that get a set of Person IDs which are placed in the designated folder. The application runs the selected report and adds the people specified by the report to the offering as learners.
Managing Existing Learners
On the Manage Learners page, you can view all learners currently enrolled in the offering, either by you or learners themselves. You can withdraw a learner’s enrollment and manually set the status of a learner to Completed. To perform these tasks:

1. Go to the Manage Learners page. In the Search Learners section, search for learners by name or assignment status.
2. You can withdraw a learner’s enrollment if the learner has either not started the offering or is in progress. You must provide the withdrawal reason and comments in the Withdrawal window. This cancels the enrollment and also the requirement (for Required assignment type) or recommendation (for Recommended assignment type).

Manage Learning Assignments and Learning Initiatives: Explained
The learning administrator can manage learning assignments and initiatives in the Learners page of the Administrator work area in the following tabs:
- Learning Assignments
- Learning Initiatives

Manage Learning Assignments
Search for learning assignments by assignment or learning item or initiative names or by the status of assignments. Use the existing Saved Searches list and find the assignments. You can review learning assignments and manage them by performing the following tasks:
- Change the assignment status
- Edit the assignment
- Manage activities of the assignment
- Create required, voluntary, and recommended assignments

Manage Learning Initiatives
Search for learning initiatives by initiative type, learning item, or keywords. Use the existing Saved Searches list and find the initiative assignments. You can review learning initiatives and manage them by performing the following tasks:
- Edit learning initiative details
- Cancel learning initiative assignments
- Add required, voluntary, and recommended initiatives

FAQs for Learning Assignments
How can I find a course or specialization with a specific outcome to assign to a learner?

Use Search by Learning Outcomes on the Manage Catalog page to find courses or specializations with specific learning outcomes. Type keywords related to the learning outcome to run a Basic search. Else, use Advanced search to type keywords containing specific attributes or values used in the learning outcome. From the search results, select the course and open the offering details. Use Manage Learners to assign the course or specialization to learners.

What's the difference between learning assignment and learning initiative?

A learning assignment is a piece of learning assigned to a learner or a group of learners on a specific date. For example, the Agile Project Management course is assigned to employees in a specific organization because they have to use this methodology for a specific project.

A learning initiative is an ongoing assignment for a group of learners. For example, you assign Ethics and Business Conduct for employees joining the organization after 1 January 2017. You can create a learning initiative that creates assignments to all employees who join the organization and repeat the course every 2 years.
# Contextual Learning

## Contextual Learning in Application Pages: Explained

Edit the application pages to embed learning items that enhance application work flows. The Learning resource catalog components enable you to present learning items that are relevant to the business workflow.

Navigate to the Learning resource catalog components using the Page Composer, select View menu > Source > Add > Add Content > Learning Management folder:

- Learning Association Component
- Learning Showcase Component
- Voluntary Assignment Component
- Required Assignment Component

### Learning Association Component

Use the Learning Association component to associate learning items with a business object or page context in the application. The Learning Showcase and Assignment components leverage the Association component and presents the learning items.

The following graphic indicates the roles and the task they perform with the Association component:

The administrator adds the component to a specific place of the application page. For example, an application page in profile management (Job Role Details) and sets its context and size using the Page Composer, through expression language.
parameters. This is a one-time task. Then the component will surface in all instances of the profile management page. All Job Roles will have the Association component embedded in it.

The learning specialist will then use this component in the application page to specify the learning items and how they must be presented to the learner in the context of that specific business object.

The learner will then view the learning items which appear in the business context from a different page in the self service. For example, by adding the Learning Showcase Component to the Job Roles self-service page, learning items relevant for a particular role appear in My Account > User Details page Roles region.

Learning Showcase Component
The Showcase component enables the display of one or more learning items in various presentation formats. You can configure the component in such a way that it only displays learning items relevant to a particular application page. For example, the component shows learning items related to a specific business object type such as a job profile inside the job profile description page of employee's self service. You can configure the look and feel of this component. Learning items are made available to a learner as cards in a swim lane with each learning item displaying the title, contributor name, duration, number of views and so on.

The Learning Showcase component can use the Learning Association component as a potential source of learning activities or learning outcomes, if the page where the component is added contains sufficient reference to a Profile Item such as Competencies or Licenses and Certificates.

Voluntary Assignment Component
The Voluntary Assignment component enables the user of a specific application page (when tied to a business process or a specific business object) to create voluntary learning assignments for self or someone else. The assignment is then saved in the database directly from this page without navigating away from the page. Moreover, the database keeps the context of the business object and the business process for future potential reporting. For example, you can add learning items relevant to Planning and Organizing goals and associate them to the Performance Review page in the HCM application. The application creates assignments for employees and they start learning from the performance review process.

Use the assignment component to enable the learner to search for learning items from different sources, from the entire learning catalog or only from the learning items that are specific to a context using the Association component or Learning Outcomes.

Required Assignment Component
The Required Assignment component works in the same way as the Voluntary Assignment component, excepting:

- Assignment type is required
- You can bind the business process page with validation actions such as Submit or Save to the completion of the learning items

For example you can prevent employees or managers to start on the compensation review process until they complete a specific learning item. The Save or Submit buttons can be dimmed.
Configuring Learning Showcase Component: Points to Consider

Use the Learning Showcase component to display one or more learning items in various presentation formats. Using the Page Composer, go to the page where the component is added and click the gear wheel in the Showcase component and configure the style and context options.

Style

Not only can you embed the learning items to an application page, you can define and configure the style options to present the learning items to the learner:

- Showcase Styles
- Attributes to Show
- Sort Options
- Cover Art Handling

Showcase Styles

Use one of the following showcase styles to present learning items in the showcase component:

<table>
<thead>
<tr>
<th>Showcase Styles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single item</td>
<td>Displays a single learning item.</td>
</tr>
<tr>
<td>Single Thumbnail</td>
<td>Displays a single thumbnail picture of the learning item.</td>
</tr>
<tr>
<td>Single Card</td>
<td>Displays a single learning item as a card.</td>
</tr>
<tr>
<td>Items List</td>
<td>Displays multiple learning items in a list format.</td>
</tr>
<tr>
<td>Cards Swim Lane</td>
<td>Displays multiple card learning items in a swim lane in a horizontal view with back and next page buttons.</td>
</tr>
<tr>
<td>Swim Lane</td>
<td>Displays multiple learning items in a swim lane in a horizontal view with the back and next page buttons.</td>
</tr>
</tbody>
</table>

Note: When multiple learning items exist, opt for the **Enable scrolling** option. If you don’t opt for scrolling, the component displays as many learning items as can fit in the space available.
Attributes to Show

Depending on the selection of showcase styles, you can specify which of the following attributes is available to learners when viewing the learning items:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thumbnail</td>
<td>Shows the smaller version of the video or tutorial</td>
</tr>
<tr>
<td>Title</td>
<td>Shows the title of the learning item as an overlay</td>
</tr>
<tr>
<td>Action button</td>
<td>Includes an action button so that learners can start, resume, evaluate, or restart viewing the learning item</td>
</tr>
<tr>
<td>Learning item type icon</td>
<td>Shows the learning type icon on the learning item, for example an arrow is for a video</td>
</tr>
<tr>
<td>Contributor</td>
<td>Shows the name of the person who contributed the learning item</td>
</tr>
<tr>
<td>Number of views</td>
<td>Shows the number of times the learning item was viewed</td>
</tr>
<tr>
<td>Duration</td>
<td>Shows the duration required to view the learning item</td>
</tr>
</tbody>
</table>

Cover Art Handling

For learning items that have cover art, based on the image used, you can set it to the following options:

- **Zoom**: Scales the image proportionally to fit in the component region by cropping. May result in a border at the top and bottom or sides depending on the original image size.
- **Full**: Scales the image proportionally to fit in the component region without cropping.

💡 **Tip**: Preview the learning items according to the defined style options before you make it available to the learner.

Set the sorting order of the learning items in the component. You can sort by any one of the following options:

- **Featured Learning**: Sorts learning items that are marked as Featured in the Association component
- **Most Recent**: Sorts learning items that are published recently
- **Most Liked**: Sorts learning items by the most number of likes
- **Most Viewed**: Sorts learning items that are most viewed

You can have a requirements checklist and accordingly specify the options when configuring the component.

Page Context

Set the context of the page where you embed the learning items by specifying the Source Type and Source ID. Learning items associated with this source are automatically listed in the component. When the associated learning item doesn’t exist, the page to which the component is added will not show any learning items.
Configuring Learning Assignment Component Options: Points to Consider

Use the learning assignment component to enable self-service users to create learning assignments in the context of another HCM process. For example, the project implementation team can configure an assignment component on the Job Details page for the learner, manager, or learning administrator. This option allows self-service users to manage their learning assignments and browsing in the catalog without having to leave the page in which they are working. Page users can search in the catalog, add one or more items as assignments and save the page of the current business process.

You can configure the component on its style, the assignment options and the available learning items. Page action bindings are also available for required learning assignments to avoid employees to carry on with a business process before they can actually complete a specific learning item. The Voluntary Learning Assignment and Required Learning Assignment Components work differently, and the differences in setup are highlighted in this topic.

Style

As well as embedding the learning assignment to an application page, you can also define and configure the following style options to present the learning items to the learner:

- Assignment Styles
- Attributes to show
- Sort options
- Cover art handling

Use one of the following showcase styles in the table below to present learning items in the assignment component:

<table>
<thead>
<tr>
<th>Assignment Styles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single item (Only for Voluntary Assignments Components)</td>
<td>Displays a single learning assignment in a list.</td>
</tr>
<tr>
<td>Single Thumbnail (Only for Voluntary Assignments Components)</td>
<td>Displays a single thumbnail picture of the learning assignment.</td>
</tr>
<tr>
<td>Single Card (Only for Voluntary Assignments Components)</td>
<td>Displays a single learning assignment as a card.</td>
</tr>
<tr>
<td>Items List</td>
<td>Displays multiple learning assignments in a list format.</td>
</tr>
<tr>
<td>Cards Swim Lane</td>
<td>Displays multiple card learning assignments in a swim lane in a horizontal view with back and next page buttons.</td>
</tr>
<tr>
<td>Swim Lane (Only for Voluntary Assignments Components)</td>
<td>Displays multiple learning assignments in a swim lane in a horizontal view with the back and next page buttons.</td>
</tr>
</tbody>
</table>
When multiple learning assignments exist, opt for the Enable scrolling option. If you don’t opt for scrolling, the component displays as many learning items as can fit in the space available.

Depending on the selection of assignment styles, you can specify which of the following attributes is available to learners when viewing the learning items:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thumbnail</td>
<td>Shows the smaller version of the video or tutorial.</td>
</tr>
<tr>
<td>Title</td>
<td>Shows the title of the learning item as an overlay.</td>
</tr>
<tr>
<td>Action button</td>
<td>Includes an action button so that learners can start, resume, evaluate, or restart viewing the learning item.</td>
</tr>
<tr>
<td>Learning item type icon</td>
<td>Shows the learning type icon on the learning item, for example an arrow is for a video.</td>
</tr>
<tr>
<td>Duration</td>
<td>Shows the duration required to view the learning item.</td>
</tr>
<tr>
<td>Due in Days (Required assignment component only)</td>
<td>Shows for Required Assignment Component only. Displays the time remaining before the assignment is overdue.</td>
</tr>
</tbody>
</table>

For learning items that include cover art, based on the image used, you can set it to the following options:

- Zoom: Scales the image proportionally to fit in the component region by cropping. May result in a border at the top and bottom or sides depending on the original image size.
- Full: Scales the image proportionally to fit in the component region without cropping.

**Tip:** Preview the learning items according to the defined style options before you make it available to the learner.

### Learning Assignment

Set up various parameters about the assignments that the employee can add and save by using the page.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State of new assignment</td>
<td>Determines if the newly created assignments become active when saving the page or if they have to go through the request process (triggering the approval workflows).</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Determines if the person to whom the selected learning items are assigned is the current page user or another type of person (the person using the page for someone else or the person concerned by the process might be different people). You can designate the assignee through expression language.</td>
</tr>
<tr>
<td>Assign as</td>
<td>Determines if the person triggering the assignment is the page user, or another user designated through expression language or if the assigner is designated by a pre-defined descriptive value.</td>
</tr>
</tbody>
</table>
## Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Due in (required assignment component only)</td>
<td>For required assignment component only. Defaults the due date by a number of specified days after the assignment is created and saved.</td>
</tr>
<tr>
<td>Default comment (required assignment component only)</td>
<td>For required assignment component only. Defaults the assignment comment after the assignment is created and saved.</td>
</tr>
<tr>
<td>Context Source Type</td>
<td>Determines the database reference where the context of the business process or object is saved.</td>
</tr>
<tr>
<td>Context Source ID</td>
<td>Determines the ID parameter binding the assignments and the learning assignment.</td>
</tr>
<tr>
<td>Include withdrawn assignments</td>
<td>Determines if the assignments created in the context of the business process or business object which have been withdrawn, will still display.</td>
</tr>
</tbody>
</table>

## Learning Item Selection

Configure the array of learning activities the end user can select when creating assignments. Enable the user to select from the whole catalog or from a specific contextual or fixed selection of learning items.

<table>
<thead>
<tr>
<th>Selection Restriction</th>
<th>Description</th>
<th>Sub Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select any Learning Item in the Catalog (Voluntary Assignment Component only)</td>
<td>The component indicates to the page user creating a learning assignment that they can select any learning item from the catalog, even using a saved search.</td>
<td>NA</td>
<td>End user can search the global catalog of learning items to create learning assignments.</td>
</tr>
<tr>
<td>Select Featured Learning Items Associated With Page Context (Voluntary Assignment Component only)</td>
<td>The component leverages the association component which associates learning items with a specific business object.</td>
<td>Source Type</td>
<td>Database link to where the source type from the association component is stored.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Source ID</td>
<td>Binding parameter ID picks up the correct ID of the business object. Associate learning items to the business object using the association component. Only learning items associated with the business object are searchable by page user to create an assignment.</td>
</tr>
<tr>
<td>Select Featured Learning Items Associated with Learning Outcomes (Voluntary Assignment Component only)</td>
<td>The component leverages the learning outcomes as a source to display learning items. Learning items associated with profile items that exist in the page will display.</td>
<td>Outcome Source</td>
<td>Determines if the learning outcome is designated through a profile item ID, content item ID or learning outcome name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Object ID</td>
<td>Binding Parameter dynamically selects the correct ID of the learning outcome. Associate the learning items to the learning outcome through the learning outcome functionality. Only learning items associated</td>
</tr>
</tbody>
</table>
### Page Integration (Required Assignment Component)

This tab allows you to bind an action button of the page process you modify. You configure the page action button to appear inactive until the learner completes specifically designated learning items.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Satisfied Assignment Requirements</td>
<td>This gives you the identifier of the component current. Copy and paste this parameter in the activation condition of the button of your choice. It joins the activation of the button to the completion of all the assignments of all learning preselected in this component.</td>
</tr>
<tr>
<td>Dependant page component IDs</td>
<td>Copy and paste the identification code of one or several buttons that should remain locked until the assignments are complete. Find the IDs of these buttons through page composer or page source code. The button identification can change from one page to another.</td>
</tr>
</tbody>
</table>

### Adding and Configuring Learning Components to Job Roles: Worked Example

The goal is to embed learning items relevant to the application context in an application page. This example comprises the following tasks in embedding learning relevant to a job role:

- Adding and Configuring Learning Association Component
- Adding and Configuring Learning Showcase Component
- Adding Learning Items to Learning Association Component
- Viewing Learning Items in Application Context

The administrator adds the learning components to the page using Page Composer, the learning specialist adds learning items to the component, and the learner can view the learning items in context to the application page he is viewing and sees the learning items.

### Adding and Configuring Learning Association Component

1. Sign in to the application as a user with configuration privileges
2. On the Home page, click **My Workforce** then **Profiles**. In the **Tasks** tab, select **Manage Model Profiles**.
3. Search for model profiles and select one to edit the profile in the Job Profile page.
4. In the **Setting and Actions** menu, select **Structure Pages**.
5. In the **Structure Pages** window, select the level: **Site**, HCMCountry, or HCMOrganization, at which you want to add the learning.
6. From the **View** menu select **Source**.
7. When you click on the region to configure, the **Confirm Task Flow Edit** window appears. Click **Edit**.
8. Select the region of the page where you want to add the component. Click **Add Content**. The selected region is highlighted in a rectangle and you can view the details of the component in the pane.
9. In the Add Content window, click **Open** in the **Learning Management** folder to add the component.
10. Click **Add** in the Learning Association component. The selected component is added to the specified region in the **Model Profiles** page.
11. Click **Close**. You return to the page where the component is added.
12. From the **View** menu select **Design**. The component you just added to the region is displayed in the page.
13. Click the **Edit** gear wheel icon to configure the component.
14. Specify ORA_JOB_PROFILE Source Type and #{pageFlowScope.pProfileId} Source ID.
15. Enter a title **Role Training** for the Association component.
16. Click **Save and Close**.

---

### Adding and Configuring Learning Showcase Component

1. From the **Home** page, navigate to **About Me** and **Career Development** and then to the **Explore Roles** page.
2. In the **Setting and Actions** menu, select **Structure Pages**.
3. In the **Structure Pages** window, select the level: **Site**, HCMCountry, or HCMOrganization, at which you want to add the learning.
4. From the **View** menu select **Source**.
5. When you click on the region to configure, the **Confirm Task Flow Edit** window appears. Click **Edit**.
6. Select the region of the page where you want to add the component. Click **Add Content**. The selected region is highlighted in a rectangle and you can view the details of the component in the pane.
7. In the Add Content window, click **Open** in the **Learning Management** folder to add the component.
8. Click **Add** in the Learning Showcase component. The selected component is added to the specified region in the **Explore Roles** page.
9. Click **Close**. You return to the page where the component is added.
10. In the Showcase Component region, click the **Edit** gear wheel icon to configure the component and define the style and context options.
11. Click the **Context** tab and specify ORA_JOB_PROFILE as the **Source Type** and ProfileId as the **Source ID**.
12. Click the **Style** tab and specify the **Title** **Role Training**. The title you provide here appears just below the Showcase Component title in the page you want to embed the learning items.
13. Select the **Cards Swim Lane** showcase style for the learner to view the learning items as cards in a swim lane.
14. In the **Attributes to Show** region, select the check boxes, **Thumbnail**, **Contributor**, **Title**, **Action button**, **Duration**.
15. Select **Featured Content** sort option. Learning items in the component are sorted by featured content.
16. Select the **Enable scrolling** check box so that learners can scroll through the learning items. You can preview the showcased learning items in the Preview region as you specify the options.
17. Click **Save and Close**.
18. Click **Close** to close the page composer and then view the just added component in the page.
Adding Learning Items to Learning Association Component

After the administrator adds the component to the page, the learning specialist can add and delete the learning items from the Association component. Associate the business object with relevant learning items. For example, associate videos that give an overview about a given job profile.

1. Navigate to the Manage Model Profiles page, Association Component region.
2. View the learning items listed for the source type. Then add a video you have published, click Add.
3. In the Search and Select Videos window, select My Published Items and enter the name of the video and click Search.
   You can add videos published by you or anyone in the application.
4. From the search results, select one or more learning items and click Add.
5. The selected items are added to the component. Click the Featured Learning icon adjacent to the learning item.
   Featured items appear at the top of the table for the learner.

Viewing Learning Items in Application Context

Learners can now view relevant videos that are associated to the roles and job profiles. When viewing the job profile details, learners now can view the videos per the defined options:

- View videos associated to the job profile
- Scroll through videos cards in the swim lane
- Play videos
- View video attributes:
  - Thumbnail
  - Title
  - Contributor
  - Duration

1. Navigate to the Explore Roles page and view the learning items in the Showcase Component region.
2. Select a role and view the associated videos.
3. Select the video and play it.

Related Topics

- Working with Components in Page Modifications: Procedure
- Page Component Properties: Explained

FAQs for Contextual Learning
What's Featured Learning?

Learning content that represents the learning for a specific group of learning items. When you set a learning item as Featured Learning in the Association component, that particular item appears first in the list for a learner.

You can mark only one item as featured. When configuring the Showcase component, you can sort by featured learning.

How can I sort learning items order in the Showcase component?

You can set one of the following Sort options in the Configure Showcase Learning Items page:

- Featured Learning
- Most Recent
- Most Liked
- Most Viewed
12 Learning Setup

Evaluations

Associating an Evaluation to Offerings: Procedure

You can specify a default evaluation for an offering. You can associate the default evaluation with an offering or override the default and add another evaluation. This topic details the steps to set up a default evaluation and override the default evaluation for an offering.

Prerequisites

Before you begin, perform the following steps:

- Use the Manage Questionnaires task list in the Setup and Maintenance work area to create questionnaires for use in Learning.
- Select Learn as the subscriber in the task list. If you don’t specify this subscriber code, you will not be able to view Learn questionnaires in the application. For example, if you create questionnaires in Performance, you can’t view them in Learning.

Overriding Default Evaluation

You can use an evaluation in self-paced, instructor-led, or blended offerings. If you don’t want the offering to include an evaluation, leave the Enable evaluation check box unchecked. To include an evaluation, follow these steps:

1. In the Administrator work area, select Learning Catalog, and then click the Offerings tab.
2. Search for and select an offering.
3. From the Offering Details page, select the Definition tile and click Edit.
4. In the Activities tab, select the Enable evaluation check box to use an evaluation for the offering.
5. You can use the default evaluation or override it with another one.
   a. To override, select Use another evaluation.
   b. Click Add Evaluation to search for and select an evaluation.
   c. Click Apply
   d. You will find the evaluation name and description. Click Preview to view the evaluation.
6. Select Yes for the Required for Completion option. The learner must complete the evaluation for the offering to be marked as complete. Only after the learner completes the evaluation, the offering can be marked complete.
7. Click Save and Close.

Setting up Default Evaluation

If you want to associate a default evaluation to an offering, perform the following steps:

1. From the Home page select My Workforce, then Learning. Then select Manage Setup tab.
2. On the Manage Learning Evaluations Default Settings page, click Edit. All the offering types, Blended, Instructor-Led, and Self-Paced, are in separate regions.
3. Select the Enable evaluation check box for each of the offering types.
4. Click Add Evaluation and then search for and select an evaluation.
5. You will find the evaluation name and description. Click **Preview** to view the presentation of the evaluation.

6. Select **Yes** in the **Required for Completion** option. In a required evaluation, the learner must complete the evaluation for the offering to be marked as complete. Then the status can change to **Completed**.

7. Click **Save**.

Based on the specified options, the evaluation appears in offerings. You can use the default questionnaire, override it, or can even avoid evaluations.

**Related Topics**
- Questionnaires: Explained
- Questionnaire Templates: Explained
- Questionnaire Questions and Responses: Explained
- Creating a Questionnaire: Procedure

---

**Social Network Conversations**

**Enabling Social Network Conversations in Learning: Procedure**

Use the settings in the **Social Network Conversations** tab on the **Manage Setup** page to enable social network conversations in learning items. When you enable social network conversations, learners view the **Social** tile and content area in course, specialization, or offering. They can join, share, and collaborate on the learning item with their peers, other learners, or instructors.

You can restrict the social network conversation to enrolled learners only or open it for not enrolled learners too. This topic details the steps to enable global options so that enrolled learners can view and collaborate on all specialist-created content.

**Enabling Social Network Conversations**

To enable social network conversations at the course, specialization, or offering level:

1. In the **Social Network Conversations** tab, click **Edit**.
2. Select **Yes** for **Show Social Conversations for User Created Content**.
3. Select **Yes** for **Show Social Conversations for Specialist Created Content**.
4. Click **Save and Close**.

**Restricting Social Network Conversations**

To restrict social network conversations from all learners to only enrolled learners in the course, specialization, or offering:

1. In the **Social Network Conversations** tab, click **Edit**.
2. Select **Enrolled learners** for each of the following:
   - View Social Conversations on Specialization
   - View Social Conversations on Course
   - View Social Conversations on Instructor-Led Offering
   - View Social Conversations on Self-Paced Offering
View Social Conversations on Blended Offering

3. Click **Save and Close**.

**Related Topics**
- Social Networking with Learning: Explained

**External Providers**

**Configuring YouTube Video Search: Points to Consider**

Enable YouTube Video Search so that learners can search for YouTube videos when creating the tutorials. For more details see Google’s YouTube Data API Overview.

**Configure Parameter Options**

You enable and configure YouTube Video Search on the **External Providers** tab, **Manage Setup** page in the Administrator work area. The following table explains YouTube configuration parameters options:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>YouTube API Key</td>
<td>Enter the unique identifier for your project, which you create on the Credentials page of the Google API Console.</td>
</tr>
<tr>
<td>Video License Type</td>
<td>Select to restrict the videos in search results to a specific license type or to show videos with any license type. YouTube videos can have the Creative Commons license or the standard YouTube license.</td>
</tr>
<tr>
<td>Safe Search Mode</td>
<td>Select to exclude restricted content from search results. The options are:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Strict</strong> excludes all the restricted content from search results.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Moderate</strong> excludes content that’s restricted in the user’s locale.</td>
</tr>
<tr>
<td></td>
<td>- <strong>None</strong> doesn’t filter the search results. Includes all the content.</td>
</tr>
<tr>
<td>Maximum Result Set Size</td>
<td>Enter a number up to 50 to specify the maximum number of search results. The default value is 6.</td>
</tr>
<tr>
<td>Publisher ID Filter</td>
<td>Optionally, enter a channel identifier to restrict search results to videos created by a single channel.</td>
</tr>
<tr>
<td>Region Code Filter</td>
<td>Optionally, enter a region code to restrict search results to videos from publishers in a single region.</td>
</tr>
</tbody>
</table>

**Related Topics**
- YouTube Data API Overview
- Google API Console
- Authoring a Tutorial: Worked Example
Profile Options for Learning Features: Explained

Use predefined profile options in the Setup and Maintenance work area to review and set the options as required for your organization. By default, all profile options in Oracle Learning Cloud are enabled. Deselect the specific profile option to disable the feature in your application.

To review profile options in the application, perform the following:

1. Navigate to the Setup and Maintenance work area and open the Manage Administrator Profile Values task.
2. Search for and select the profile option.
3. Edit and set the profile values.
4. Click Save and Close.

Note: Changes in the profile values take effect for a user on the next sign in.

The profile options used in Learning are explained in the following table:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Profile Option Code</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Social Network</td>
<td>Not Applicable</td>
<td>Enables the use of OSN in your application</td>
<td>Manage Oracle Social Network Objects&gt; Work Life&gt; Learning Item Object&gt;Learning Content Attributes. Verify attributes such as Name, Description, Type of Learning Item</td>
</tr>
<tr>
<td>Mass Assignments</td>
<td>WLF_RBA_BI_FOLDER</td>
<td>Enables you to configure the Shared Folder in OTBI and create the Learning folder in Human Capital Management</td>
<td>When configuring analysis objects, select the Worker object and the Person ID field. The Person ID must exist in the report for the analysis to work with Learning Assignments. The Person ID attribute is used in mass assignment processing.</td>
</tr>
<tr>
<td>Learning Outcomes</td>
<td>WLF_ENABLE_LEARNING_OUTCOMES</td>
<td>Enables you to configure Learning Outcomes to a course and specialization.</td>
<td>You must edit the content type for Learning as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Go to My Workforce&gt;Profiles&gt;Person Profiles&gt;Manage Content Types.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Search for and select the content type and click Edit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the Subscribers tab of the content type and add WLFLM Learning Outcomes as the subscriber</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Click Save.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Feature</th>
<th>Profile Option Code</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Review the content items and create, if required.</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td>Ensure that the content types such as Certifications, Competencies exist in the Person model.</td>
<td></td>
</tr>
<tr>
<td>Learning Evaluations</td>
<td>WLF_ENABLE_QUESTIONNAIRES</td>
<td>Enables you to configure Questionnaires in Learning</td>
<td>Questionnaires are created under the Learn subscriber.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set up default questionnaires to an offering by specifying the options in the Manage Setup page Evaluations tab.</td>
<td></td>
</tr>
</tbody>
</table>

**Related Topics**

- Profile Options: Overview
- Setting Profile Option Values: Procedure
- Creating and Editing Profile Options: Procedure
- Creating a Course: Worked Example
- Creating a Specialization: Worked Example

**Scheduled Processes in Oracle Learning Cloud: Overview**

Run learning-related scheduled processes for a set of records for a specific business need in Learning. The learning specialist runs the following processes:

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deploy Required Viewing to Targeted Users</td>
<td>Processes the required viewing of assignments created by a manager. This a single entry, but the process deploys the required viewing to multiple targeted users in the organization. For example, members of an organization when selected as the target.</td>
</tr>
<tr>
<td>Reconcile Dynamic Assignments</td>
<td>Generates a list of people from the analysis report. When an assignment rule targets a set of learners and assigns them a learning item, the process reconciles assignments with person IDs added or removed based on the assignment rule.</td>
</tr>
</tbody>
</table>
### Using Learning

#### Chapter 12

#### Learning Setup

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluate Person IDs for Assignment Rule</td>
<td>When a new assignment rule is created that targets a set of users and assigns them a learning item, the process looks at different person profiles and extracts the learners targeted by the assignment rule.</td>
</tr>
<tr>
<td>Rebuild Learning Item Indexes</td>
<td>Builds an index for learning items. The index aids in searching for learning items by keywords in the application.</td>
</tr>
</tbody>
</table>

**Note:** The application automatically runs some of the processes such as Pending Requests for a community. The administrator or the community manager don’t run or schedule this process. The number of pending requests are displayed on a community tile in the My Learning page.

**Related Topics**
- Scheduled Processes: Explained
- Scheduled Process Options: Examples
- Scheduled Process Statuses: Explained

### Creating Deep Links in Learning: Procedure

Deep links allow you to open pages without navigating through a menu structure. For example, you create a deep link to a learning item, then copy and paste that link to an email message or notification. The recipient can use the link to directly access the learning item from the email or notification.

You can create deep links, for both self-service learners and administrators, to the objects shown in this table.

<table>
<thead>
<tr>
<th>Learner Role</th>
<th>Learning Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Self Service</td>
<td>• Course</td>
</tr>
<tr>
<td></td>
<td>• Specialization</td>
</tr>
<tr>
<td></td>
<td>• Video</td>
</tr>
<tr>
<td></td>
<td>• Tutorial</td>
</tr>
<tr>
<td></td>
<td>• Community</td>
</tr>
<tr>
<td></td>
<td>• Offerings</td>
</tr>
<tr>
<td>Administrator</td>
<td>• Specialization</td>
</tr>
<tr>
<td></td>
<td>• Course</td>
</tr>
<tr>
<td></td>
<td>• Offering</td>
</tr>
<tr>
<td></td>
<td>• Community</td>
</tr>
</tbody>
</table>

To enable visibility of learning item links to learners, use Page Composer to place a direct link to the learning item on a Learning Cloud page.

1. Open Page Composer in Source View mode and select the area in which you want to place a learning item link.
2. Add the HTML element to the page.
3. Edit the HTML element.
4. Select the Expression Builder for the value.
5. Copy and paste the Deep Link Page Composer snippet.
6. Close the configuration window and confirm that the link displays in Source View mode.
7. Close Source View mode and confirm the link displays properly on the page to end users.

Administrators can access shareable links to catalog items from the Learning Catalog page.

1. From the Home page, select My Client Groups > Learning.
2. On the Administrator Dashboard, select Learning Catalog > Offerings, Courses, or Specializations.
3. Search for a course.
4. In the Search Results, click a link in the Offering Number, Course Number, or Specialization Number column.
5. In the pop-up window that appears, select one of three options:
   - Self-Service Link: a URL that can be copied and shared, providing direct access to the item’s self-service details page.
   - Embed Code for Self-Service Link: HTML code that can be copied, which wraps the self-service link.
   - Administrator Link: a URL that can be copied and shared, providing direct access to the item’s administrative details page.

   **Note:** In all cases, the user accessing these deeplink URLs still requires authentication and is bound by the access control (self-service access rules for a self-service link, functional and data security for an administrative link) defined on the learning catalog item.

**Related Topics**

- Deep Links: Explained
13 Security

Standard Application Users for Oracle Learning Cloud: Overview

The application users are defined using security roles and privileges that they are granted. It enables users to perform various tasks in the application.

The following are the standard user roles:

- Learning Administrator
- Learner
- Learner Manager

Learning Administrators

The Learning Specialist job role provides the reference security definition for a standard learning administrator. It contains all the necessary functional and aggregate privileges to enable administrator functionality in Oracle Learning Cloud. You can use this job role but must not grant directly to users. You must create a data role in Workforce Structures > My Workforce. The data role will instantiate the Oracle Learning Cloud data security policies contained in the aggregate privileges in the job role. The initialization of the data security policies is based on the Person Security Profiles defined in the data role and is what grants users their access to the data within the Oracle Learning Cloud application.

Learners and Learner Managers

The Employee and Line Manager abstract roles provide the reference security definitions for learners and learner managers, respectively. They contain all the necessary functional and aggregate privileges to enable all learning self-service functionality in Oracle Learning Cloud, among others. You should not use the abstract roles directly. You should copy the abstract role to create your own custom versions. This protects you from further additions to these abstract roles over time and avoids unwanted additional features being enabled automatically for your users.

The learning administrator data role requires additional manual data policy setup tasks to complete the configuration. Some of the administrator data policies don’t depend on the Person Security Profiles, and therefore you must create them manually. To do this, you must modify the data policies of this data role in the security console and define additional data policies.

For both custom abstract roles, you must initialize data policies in Workforce Structures > My Workforce. The security profiles will instantiate the Oracle Learning Cloud data security policies contained in the aggregate privileges in the custom employee and line manager abstract roles.
Granting Roles to Users

After setting up the data role or abstract role, you must grant the data roles to users by doing one of the following in the security console:

- Edit the user account and add the data role
- Edit the data role and add users to it

For the standard user set up, you must grant the following roles to the users:

<table>
<thead>
<tr>
<th>Users</th>
<th>Granted Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Custom employee abstract role</td>
</tr>
<tr>
<td>Line Manager</td>
<td>Custom employee abstract and custom line manager abstract roles</td>
</tr>
<tr>
<td>Administrator</td>
<td>Custom employee abstract role, Learning Administrator data role, and custom line manager abstract role (if the administrator is also a line manager)</td>
</tr>
</tbody>
</table>

The standard roles can be replaced by custom roles or as required. After granting the data roles to users, users are ready to access Oracle Learning Cloud and its features. For more restricted capabilities, you can replace standard roles with custom roles.

Related Topics

- Role Types: Explained

Standard Learning Administrators: Explained

The Learning Specialist role enables a user to manage catalog learning items, self-paced online offering content, training resources, assignments, initiatives and setup in the Administration work area.

The following table describes functional privileges required to create questionnaires that can then be used in the application for evaluations. These privileges are normally granted for other HCM roles such as Human Resources Specialist. Therefore you can add it to the Learning Administrator role, if no other role containing them is granted to the user already.

<table>
<thead>
<tr>
<th>Role Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Questionnaire Templates</td>
<td>Allows creating, updating, and deleting of questionnaire templates</td>
</tr>
<tr>
<td>Manage Questionnaires</td>
<td>Allows creating, updating, and deleting of questionnaires</td>
</tr>
<tr>
<td>Manage Questions</td>
<td>Allows creating, updating, and deleting of questions that will be included in the library</td>
</tr>
</tbody>
</table>
Standard Learners: Explained

The employee abstract role contains all necessary privileges enabling users to consume and contribute learning in Oracle Learning Cloud.

The standard Learner users can perform the following relevant tasks:

- Access the **What to Learn** page
- Access the **My Learning** page and the learning profile of their peers
- Search and view learning items
- View and complete their voluntary and required learning assignments
- View and complete learning evaluations
- Voluntarily enroll into learning items
- Join and participate in learning communities as a member or manager
- View recommendations they have received
- Publish videos
- Author tutorials
- Create and manage learning communities
- Recommend learning items to other learners
- Access mobile Web features

Data Security Policies and Security Profiles

A learner’s data policies are driven in part from the Person Security Profile which define the set of people and their learning items visible to them in the application.

The following table describes the person and public person security profile for a standard learner:

<table>
<thead>
<tr>
<th>Security Profile</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Profile</td>
<td>View Own Record</td>
<td>Grants access to their own learning assignments and to manage self-service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>learning items they created</td>
</tr>
<tr>
<td>Public Person Profile</td>
<td>View All People</td>
<td>Grants access to everyone in the application and the ability to view their</td>
</tr>
<tr>
<td></td>
<td></td>
<td>self-service learning contributions, and add them to learning communities</td>
</tr>
<tr>
<td></td>
<td></td>
<td>as members or managers</td>
</tr>
</tbody>
</table>
Standard Learner Managers: Explained

The Learner Manager abstract role contains necessary privileges enabling users in Oracle Learning Cloud to assign learning and track progress of that learning for the people they manage.

The Learner Manager can perform the following relevant tasks:

- View, create and manage required learning assignments for their employees
- View, create and manage voluntary learning assignments for their employees
- View recommendations their employees receive
- View recommendations they have received
- Access the learning profile page
- Recommend learning items to other learners
- Search and view learning items
- Join and participate in learning communities as a member or manager
- Publish videos
- Author tutorials
- Create and manage learning communities
- Create and manage required members in learning communities
- Create and manage required learning assignments in learning communities
- View learning items contributed by other learners in their learning profile
- Access mobile Web features

**Note:** For a learner manager to consume learning, you must grant the privileges in the employee abstract role.

Data Policies and Security Profiles

A learner manager’s data policies are driven in part from the Person Security Profile which define the set of people, their learning items and their learning assignments visible to the learner manager in the application. The following table describes the person and public person security profile for a standard learner manager.

<table>
<thead>
<tr>
<th>Security Profile</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Profile</td>
<td>View Manager Hierarchy</td>
<td>Grants access to the learning assignments and learning items of people below them in the management hierarchy</td>
</tr>
<tr>
<td>Public Person Profile</td>
<td>View All People</td>
<td>Grants access to everyone in the application and the ability to view their self-service learning contributions, and add them to learning communities as members or managers</td>
</tr>
</tbody>
</table>
Custom Learners: Explained

The standard roles outline how to setup a Learner role enabled with the Oracle Learning Cloud employee self-service functionality. You can hide certain features from the Learner role by creating custom roles. Each privilege pertains to a specific capability within the application that you can hide from the user. This topic describes common groupings of privileges that is typically granted to the Learner role.

The following application users are defined for the Learner role:

- Core Learner
- Peer-to-Peer Learner
- Recommendation-Oriented Learner

Core Learner

To consume learning in Oracle Learning Cloud, all learners must at least be defined as a Core Learner in the application. They can perform the following tasks:

- Search and view learning items
- Voluntarily enroll into learning items
- View and complete their voluntary and required learning assignments
- Join and participate in learning communities as a member or manager
- View recommendations received from others
- Access mobile Web features

The following table describes the functional privileges granted to a user enabling them as a core learner:

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Learner Self-Service Work Area</td>
<td>Access to the My Learning page from the Learning Self-Service work area</td>
</tr>
<tr>
<td>Create Noncatalog Learning Requests by Learner</td>
<td>Allows a noncatalog learning request to be initiated by learner</td>
</tr>
</tbody>
</table>

The following table describes the aggregate privileges granted to a user enabling them as a core learner:

<table>
<thead>
<tr>
<th>Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Learning Common Components</td>
<td>The core learner can access Learning common components and perform related tasks.</td>
</tr>
<tr>
<td>Manage My Voluntary Learning</td>
<td>Allows learners to join and manage their voluntary learning assignments</td>
</tr>
<tr>
<td>View Learning Communities</td>
<td>Allows learners to view their learning communities, in which they are members</td>
</tr>
<tr>
<td>View My Recommended Learning</td>
<td>Allows learners to view learning items recommended to them</td>
</tr>
<tr>
<td>Role Names</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View My Required Learning</td>
<td>Allows learners to view their required learning assignments</td>
</tr>
</tbody>
</table>

**Peer-to-Peer Learner**

In addition to the core learner capabilities, the peer-to-peer learner has the ability to contribute learning by performing one or all the following tasks:

- Publish videos
- Author tutorials
- Create and manage learning communities
- Recommend learning items to other learners
- View learning items contributed by other learners in their learning person profile

The following table describes the additional aggregate privileges granted to a user enabling them as a peer-to-peer learner. These can be granted independently if necessary.

<table>
<thead>
<tr>
<th>Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Learning Communities</td>
<td>Allows learners to create and manage learning communities</td>
</tr>
<tr>
<td>Manage Learning Self-Service Tutorials</td>
<td>Allows learners to author and publish tutorials</td>
</tr>
<tr>
<td>Manage Learning Self-Service Videos</td>
<td>Allows learners to publish videos and manage them</td>
</tr>
<tr>
<td>Manage Recommended Learning</td>
<td>Allows learners to recommend learning</td>
</tr>
<tr>
<td></td>
<td>Allows learners to view learning items recommended to them</td>
</tr>
<tr>
<td>View Learner Contributions</td>
<td>Allows learners to view the learning contributions of a person</td>
</tr>
<tr>
<td>View Public Learning Communities</td>
<td>Allows users to view the learning communities a person is a member of.</td>
</tr>
</tbody>
</table>

*Note:* No additional functional privileges are necessary

**Recommendation-Oriented Learner**

In addition to the core learner capabilities, the recommendation-oriented learner can access the *What to Learn* page and view the learning items in the following cards:

- Required Learning card
- Voluntary Learning card
- Recommended Learning card
The following table describes the additional functional privileges granted to a user enabling them as a recommendation-oriented learner:

<table>
<thead>
<tr>
<th>Privilege Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access What to Learn</td>
<td>Allows access to the What to Learn page in learning self-service work area</td>
</tr>
</tbody>
</table>

> Note: No additional aggregate privileges are necessary.

### Data Policies and Security Profiles

A learner’s data policies are driven in part from the Person Security Profile which define the set of people and their learning items visible to them in the application. The following table describes the person and public person security profile for a standard learner.

<table>
<thead>
<tr>
<th>Security Profile</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Profile</td>
<td>View Own Record</td>
<td>Grants access to their own learning assignments and to manage self-service learning items they created</td>
</tr>
<tr>
<td>Public Person Profile</td>
<td>View All People</td>
<td>Grants access to everyone in the application and the ability to view their self-service learning contributions, recommend learning to others, and add them to learning communities as members or managers</td>
</tr>
</tbody>
</table>

### Custom Learner Managers: Explained

The standard roles outline how to setup the Learner Manager role enabled with the Oracle Learning Cloud manager self-service functionality. You can hide certain features from the learner manager by creating custom roles. Each privilege pertains to a specific capability within the application that can hide from the user. This topic describes common groupings of privileges that is typically granted to a learner manager.

The following application users are defined for the Learner Manager role:

- Core Learner Manager
- Learner Manager with Assignment Privileges
- Peer-to-Peer Learner Manager
- Business Line Learner Manager

### Core Learner Manager

A Core Learner Manager can view the following learning assignments for the people they manage:

- View and track progress of required assignments in the My Team and learning profile (My Learning) pages
• View and track progress of voluntary assignments in the My Team and learning profile (My Learning) pages
• View their recommended learning items in their learning profile (My Learning) page

The core learner manager can also perform the following tasks:

• Search and view learning items
• Join and participate in learning communities as a member or manager
• View recommended learning items from others
• Access mobile Web features

**Note:** A core learner manager can’t voluntarily enroll in catalog learning items such as offerings or specializations unless the core learner manager is granted the core learner privileges.

The following table shows the aggregate privileges granted to enable the core learner manager capabilities:

<table>
<thead>
<tr>
<th>Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Learning Common Components</td>
<td>Access common learning components</td>
</tr>
<tr>
<td>View Learning Communities</td>
<td>Allows Learners to view learning communities in which they are members</td>
</tr>
<tr>
<td>View Recommended Learning by Learner Manager</td>
<td>Allows managers to view recommendations received by people in their person security profile, and learning items recommended for people in their public person security profile</td>
</tr>
<tr>
<td>View Required Learning by Learner Manager</td>
<td>Allows managers to view required learning assignments assigned to people in their person security profile</td>
</tr>
<tr>
<td>View Voluntary Learning by Learner Manager</td>
<td>Allows managers to view voluntary learning assignments assigned to people in their person security profile</td>
</tr>
</tbody>
</table>

The following table describes the functional privileges granted to a user enabling them as a core learner manager.

<table>
<thead>
<tr>
<th>Privilege Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Learner Manager Self-Service Work Area</td>
<td>Allows access to the My Team page in the Learning self-service work area</td>
</tr>
</tbody>
</table>

**Learner Manager with Assignment Privileges**

In addition to the core learner manager capabilities, the learner manager has the ability to perform one or all of the following tasks:

• Create and manage required learning assignments for their employees
• Create and manage voluntary learning assignments for their employees

The following tables describes the additional aggregate privileges granted to a user enabling them as a learner manager:
<table>
<thead>
<tr>
<th>Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Noncatalog Learning Requests by Learner Manager</td>
<td>Allows a noncatalog learning request to be initiated by a learner manager</td>
</tr>
<tr>
<td>Manage Learning Requests by Learner Manager</td>
<td>Allows managers to manage learning requests they receive</td>
</tr>
<tr>
<td>Manage Required Learning by Learner Manager</td>
<td>Allows managers to create and manage required assignments</td>
</tr>
<tr>
<td>Manage Voluntary Learning by Learner Manager</td>
<td>Allows managers to create and manage voluntary assignments</td>
</tr>
</tbody>
</table>

**Note:** No additional functional privileges are necessary.

### Peer-to-Peer Learner Manager

In addition to the core learner manager capabilities, the peer-to-peer learner manager has the ability to contribute learning by performing one or all the following tasks:

- Publish videos
- Author tutorials
- Create and manage learning communities
- Recommend learning items to other learners
- View learning items contributed by other learners in their learning person profile

The following table describes the additional aggregate privileges granted to a user enabling them as a peer-to-peer learner manager:

<table>
<thead>
<tr>
<th>Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Learning Self-Service Tutorials</td>
<td>Allows learners to author tutorials</td>
</tr>
<tr>
<td>Manage Learning Self-Service Videos</td>
<td>Allows learners to publish and edit videos</td>
</tr>
<tr>
<td>Manage Recommended Learning</td>
<td>Allows learners to recommend learning and view recommendations received</td>
</tr>
<tr>
<td>View Learner Contributions</td>
<td>Allows learners to view a person’s learning contributions.</td>
</tr>
<tr>
<td>View Public Learning Communities</td>
<td>Allows learners to view the learning communities in which they are members</td>
</tr>
</tbody>
</table>

**Note:** No additional functional privileges are necessary.
Business-Line Learner Manager

In addition to the core learner manager capabilities, a business-line learner manager can perform one or more of the following tasks:

- Create and manage learning communities
- Create and manage required members in the learning community
- Create and manage required learning assignments in the learning community
- Publish videos in the learning community and publish videos as themselves
- Publish tutorials in the learning community
- View learning items contributed by other learners in their learning profile

The following table describes the additional aggregate privileges granted to a user enabling them as a business-line learner manager:

<table>
<thead>
<tr>
<th>Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Learning Communities</td>
<td>Allows learners to create learning communities</td>
</tr>
<tr>
<td>Manage Learning Self-Service Tutorials</td>
<td>Allows learners to author tutorials</td>
</tr>
<tr>
<td>Manage Learning Self-Service Videos</td>
<td>Allows learners to publish and edit videos</td>
</tr>
<tr>
<td>Manage Learning Community Required Members</td>
<td>Allows adding required members to a community</td>
</tr>
<tr>
<td>View Learner Contributions</td>
<td>Allows learners to view a person’s learning contributions</td>
</tr>
<tr>
<td>View Public Learning Communities</td>
<td>Allows learners to view the learning communities in which they are a member</td>
</tr>
</tbody>
</table>

The following table describes the additional functional privileges granted to a user enabling them as a business-line learner manager:

<table>
<thead>
<tr>
<th>Privilege Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Learning Community Members using OTBI</td>
<td>Allows adding members to communities using OTBI analysis objects</td>
</tr>
<tr>
<td>Manage Learning Community Required Members</td>
<td>Allows adding required members to a community</td>
</tr>
</tbody>
</table>

Data Policies and Security Profiles

A learner manager’s data policies are driven in part from the Person Security Profile which define the set of people, their learning items and their learning assignments visible to the learner manager in the application. The following table describes the person and public person security profile for a standard learner manager:
Security Profile | Value | Description
--- | --- | ---
Person Profile | View Manager Hierarchy | Grants access to the learning assignments and learning items of people below them in the management hierarchy
Public Person Profile | View All People | Grants access to everyone in the application and the ability to view their self-service learning contributions, recommend learning to others, and add them to learning communities as members or managers

**Custom Learning Administrators: Explained**

The standard roles outline how to setup the Learning Administrator role enabled for the Oracle Learning Cloud administrator functionality. You can hide certain features from the administrator by creating custom roles. Each privilege pertains to a specific capability within the application that you can hide from the user. This topic describes common groupings of privileges that is typically granted to a learning administrator.

The following application users for the Learning Administrator role can be defined in the application:

- Core Learning Administrator
- Learning Content Administrator
- Resource Administrator
- Catalog Manager
- Learning Assignment Administrator
- Learning Initiative Administrator
- Learning Implementor

**Core Learning Administrator**

Core Learning Administrators can view the administration dashboard and view catalog items. No additional functional privileges are necessary.

The following table describes the aggregate privileges granted to a user enabling them as a core learning administrator:

<table>
<thead>
<tr>
<th>Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Learning Common Components</td>
<td>Access common learning components</td>
</tr>
<tr>
<td>Access Learning Administration</td>
<td>Access to the learning administration work area</td>
</tr>
<tr>
<td>View Catalog Learning Communities</td>
<td>Allows searching and viewing communities in the administrator work area</td>
</tr>
<tr>
<td>View Catalog Learning Courses</td>
<td>Allows searching and viewing courses in the administrator work area</td>
</tr>
<tr>
<td>View Catalog Learning Offerings</td>
<td>Allows searching and viewing offerings in the administrator work area</td>
</tr>
</tbody>
</table>
Role Names | Description
---|---
View Catalog Learning Specializations | Allows searching and viewing specializations in the administrator work area

> **Note:** Any one of the View privileges for the catalog learning courses, offerings, specializations, or communities may be granted to the user.

### Learning Content Administrator

Content administrators can search, view, and manage content for self-paced online offerings in the Administration work area.

The following table describes the additional aggregate privileges granted to a user enabling them as a content administrator:

<table>
<thead>
<tr>
<th>Application Users</th>
<th>Capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage eLearning Content</td>
<td>Allows administrators access the catalog resources area, and to create and manage eLearning content for self-paced offerings</td>
</tr>
</tbody>
</table>

> **Note:** No additional functional privileges are necessary.

### Resource Administrator

Resource administrators can search, view, and manage learning resources for self-paced online offerings in the **Administrator** work area. The following table describes the additional aggregate privileges granted to a user enabling them as a resource administrator:

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Training Resources</td>
<td>Allows administrators access the catalog resources area, and to create and manage resources for self-paced offerings</td>
</tr>
</tbody>
</table>

> **Note:** No additional functional privileges are necessary.

### Catalog Manager

Catalog managers can access content items and learning resources for offerings and manage catalog courses, offerings, specializations, and communities.

The functional privilege granted to the catalog manager:

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Learning Community Members using OTBI</td>
<td>Allows adding members to communities using OTBI analysis objects</td>
</tr>
</tbody>
</table>
Oracle Talent Management Cloud
Using Learning

Chapter 13
Security

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Catalog Learning Item Access</td>
<td>Allows management of catalog learning items access</td>
</tr>
<tr>
<td>Manage Catalog Learning Item Access Group</td>
<td>Allows management of catalog learning items access groups</td>
</tr>
</tbody>
</table>

The following table describes the additional aggregate privileges granted to a user enabling them as a catalog manager:

> Note: Only any one of the privileges may be granted to a user.

<table>
<thead>
<tr>
<th>Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Catalog Learning Courses</td>
<td>Allows administrators to create and manage learning catalog courses</td>
</tr>
<tr>
<td>Manage Catalog Learning Offerings</td>
<td>Allows administrators to create and manage learning catalog course offerings</td>
</tr>
<tr>
<td>Manage Catalog Learning Specializations</td>
<td>Allows administrators to create and manage learning catalog specializations</td>
</tr>
<tr>
<td>Manage Catalog Learning Communities</td>
<td>Allows administrators to create and manage learning catalog communities</td>
</tr>
<tr>
<td>Manage Learning Community Required Members</td>
<td>Allows adding required members to a community</td>
</tr>
<tr>
<td>View Catalog Learning Item Access</td>
<td>Allows administrators to view learner access details on catalog learning items</td>
</tr>
</tbody>
</table>

Catalog Manager data policies are driven in part by the Person Security Profile which define the set of catalog learning items manageable by the catalog manager in the application. The following table describes the person and public person security profile for a catalog manager.

<table>
<thead>
<tr>
<th>Security Profile</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Profile</td>
<td>View All People</td>
<td>Allows catalog courses, offerings and specializations created by anyone to be edited</td>
</tr>
<tr>
<td>Public Person Profile</td>
<td>View All People</td>
<td>Not used for catalog management</td>
</tr>
</tbody>
</table>

Learning Assignment Administrator

Learning assignment administrators can perform one or more of the following for employees they are responsible for:

- View the progress of existing required or voluntary learning assignments on catalog learning items
- View existing administrator recommendations on catalog learning items
- Manage existing required or voluntary learning assignments on catalog learning items
• Manage existing administrator recommendations on catalog learning items
• Create required, voluntary, or recommendation assignments on the catalog learning items

The following table describes the additional functional privileges granted to a user enabling them as an assignment administrator:

<table>
<thead>
<tr>
<th>Privilege Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Recommended Learning Assignment by Administrator</td>
<td>Allows creation of recommended learning assignments in the learning administration work area</td>
</tr>
<tr>
<td>Create Required Learning Assignment by Administrator</td>
<td>Allows creation of required learning assignments in the learning administration work area</td>
</tr>
<tr>
<td>Create Voluntary Learning Assignment by Administrator</td>
<td>Allows creation of voluntary learning assignments in the learning administration work area</td>
</tr>
<tr>
<td>Manage Recommended Learning Assignment Records by Administrator</td>
<td>Allows managing recommended learning assignments in the learning administration work area</td>
</tr>
<tr>
<td>Manage Required Learning Assignment Records by Administrator</td>
<td>Allows managing required learning assignments in the learning administration work area</td>
</tr>
<tr>
<td>Manage Voluntary Learning Assignment Records by Administrator</td>
<td>Allows managing voluntary learning assignments in the learning administration work area</td>
</tr>
</tbody>
</table>

The following table describes the aggregate privileges:

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Learning Assignments by Administrator</td>
<td>Allows searching and viewing learning assignments in the administrator work area</td>
</tr>
</tbody>
</table>

Learning assignment administrator data policies are driven by the Person Security Profile which define the set of people to whom the administrator can assign learning in the application. The following table describes the person and public person security profile for a learning assignment administrator:

<table>
<thead>
<tr>
<th>Security Profile</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Profile</td>
<td>View All People</td>
<td>Grants the ability to assign required and voluntary learning to everyone from within the administration work area</td>
</tr>
<tr>
<td>Public Person Profile</td>
<td>View All People</td>
<td>Grants the ability to assign recommended learning to everyone from within the administration work area</td>
</tr>
</tbody>
</table>
Learning Initiative Administrator

Learning initiative administrators can perform one or more of the following tasks for the employees they are responsible for:

- View the progress of existing required or voluntary learning assignments on catalog learning items
- View the existing administrator recommendations on the catalog learning items
- Create and manage required, voluntary or recommendation learning initiatives on catalog learning items

The following table describes the additional functional privileges granted to a user enabling them as an initiative administrator:

<table>
<thead>
<tr>
<th>Privilege Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Required Learning Initiative by Administrator</td>
<td>Allows creation and management of required learning initiatives in the learning administrator work area</td>
</tr>
<tr>
<td>Manage Recommended Learning Initiative by Administrator</td>
<td>Allows creation and management of recommended learning initiatives in the learning administrator work area</td>
</tr>
<tr>
<td>Manage Voluntary Learning Initiative by Administrator</td>
<td>Allows creation and management of voluntary learning initiatives in the learning administrator work area</td>
</tr>
<tr>
<td>View Learning Assignments by Administrator</td>
<td>Allows searching and viewing learning assignments in the administrator work area</td>
</tr>
</tbody>
</table>

The following table describes the aggregate privileges:

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Learning Assignments by Administrator</td>
<td>Allows searching and viewing learning assignments in the administrator work area</td>
</tr>
</tbody>
</table>

Learning initiative administrator data policies are driven by the Person Security Profile which define the set of people to whom the administrator can assign learning in the application. The following table describes the person and public person security profile for a learning initiative administrator:

<table>
<thead>
<tr>
<th>Security Profile</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Profile</td>
<td>View All People</td>
<td>Grants the ability to manage required and voluntary learning initiatives to everyone from within the administration work area</td>
</tr>
<tr>
<td>Public Person Profile</td>
<td>View All People</td>
<td>Grants the ability to assign recommended learning initiatives to everyone from within the administration work area</td>
</tr>
</tbody>
</table>
Learning Implementor

Learning implementors perform Learning Setup tasks in the Administration work area and manage learning configurations such as:

- External Providers
- Oracle Social Network Setup
- Evaluations

The following table describes the additional functional privileges granted to a user enabling them as a learning implementor:

<table>
<thead>
<tr>
<th>Privilege Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Learning Setup</td>
<td>Allows access Learning Administration settings</td>
</tr>
<tr>
<td>Manage Learning Media Platform</td>
<td>Allows access to provisioning the media platform</td>
</tr>
</tbody>
</table>

*Note:* No additional aggregate privileges are necessary.

In addition to the above functional privileges, the following table describes functional privileges required to create questionnaires that can then be used in the application as evaluations. These privileges are normally granted in other HCM roles such as Human Resources Specialist and therefore only need to be added to the Learning Administrator role if no other role containing them is granted to the user already.

<table>
<thead>
<tr>
<th>Privilege Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Questionnaire Templates</td>
<td>Allows creating, updating, and deleting of questionnaire templates</td>
</tr>
<tr>
<td>Manage Questionnaires</td>
<td>Allows creating, updating, and deleting of questionnaires</td>
</tr>
<tr>
<td>Manage Questions</td>
<td>Allows creating, updating, and deleting of questions that will be included in the library</td>
</tr>
</tbody>
</table>

*Note:* No additional aggregate privileges or data policies are necessary.

Custom Learning Moderators: Explained

The Learning Moderator role enables a user to approve, suspend, and delete learning items from human task notifications.

Aggregate Privileges

The following table describes the aggregate privileges granted to a user enabling them as a learning moderator:
Role Names | Capabilities
--- | ---
Moderate Administrator Generated Learning | Allows access to moderate catalog learning items

Moderate User-Generated Learning | Allows access to moderate and approve self-service learning items

Note: No additional functional privileges are necessary.

Data Policies and Security Profiles

A Learning Moderator data policies are driven from the Person Security Profile which define the set of people they can moderate.

The following table describes the person and public person security profile for a standard learning moderator:

<table>
<thead>
<tr>
<th>Security Profile</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Profile</td>
<td>View All People</td>
<td>Grants access to the contents of human tasks for approval and moderation of learning items created by everyone</td>
</tr>
<tr>
<td>Public Person Profile</td>
<td>View All People</td>
<td>Not used by the application</td>
</tr>
</tbody>
</table>
Glossary

**abstract role**
A description of a person’s function in the enterprise that is unrelated to the person’s job (position), such as employee, contingent worker, or line manager.

**aggregate privilege**
A predefined role that combines one function security privilege with related data security policies.

**AICC**
The Aviation Industry Computer-Based Training Committee (AICC) was a group of technology-based training professionals who developed guidelines for computer-based training for the aviation industry. These guidelines are now commonly used by other industries to manage their learning requirements. The application supports importing learning content that conforms to the AICC specification.

**condition**
The part of a data security policy that specifies what portions of a database resource are secured.

**content item**
An individual quality, skill, or qualification within a content type that you track in profiles.

**content type**
An attribute such as a skill, quality, or qualification that is added to a profile.

**course**
An entity in the learning catalog that provides generic information about the learning item. An offering is created for a course and includes specific details such as delivery mode and enrollments.

**data dimension**
A stripe of data accessible by a user. Sometimes referred to as data security context.

**data role**
A role for a defined set of data describing the job a user does within that defined set of data. A data role inherits job or abstract roles and grants entitlement to access data within a specific dimension of data based on data security policies. A type of enterprise role.
**data security policy**
A grant of entitlement to a role on an object or attribute group for a given condition.

**database resource**
An applications data object at the instance, instance set, or global level, which is secured by data security policies.

**entitlement**
Grant of access to functions and data. Oracle Fusion Middleware term for privilege.

**learning catalog**
The single point of access for all learning objects, including courses, offerings, and specializations.

**learning content**
Learning material that is associated with online offerings and delivered to learners.

**learning outcome**
A skill, competency, or certification acquired on completion of a learning assignment.

**offering**
A specific instance of a course in the learning catalog, in which learners can enroll. An offering contains details such as schedule, delivery mode, content, and enrollments.

**person profile**
A collection of skills, experience, qualifications, work preferences, and career planning information for a worker.

**rating model**
A scale used to measure the performance and proficiency of workers.

**role**
Controls access to application functions and data.

**scheduled process**
A program that you run to process data and, in some cases, generate output as a report.

**SCORM**
A specification developed by the Advanced Distributed Learning (ADL) group to enable sharing of online content across learning platforms. You can import content that is SCORM 1.2 or SCORM 2004 (Edition 2 and Edition 3) compliant.

**specialization**
A logical grouping of courses aimed to help learners achieve learning goals that a single course can’t achieve. A specialization contains one or more sections, which are containers for the courses.